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Abstract

This report discusses the development of the TfcjXspec Computer Aided Software Engineering (CASE) tool, 

which assists with the development and documentation of software in an environment where software quality 

is closely monitored, perhaps by independent regulators. The tool can assist in the development of a broad 

range of software, but is targeted at the software that implements mathematical models.

T^Xspec generates requirements specifications, design specifications and compilable code in a structured 

form while ensuring consistency between products.

The original application of TfeXspec was to assist developers of software modeling a repository for Canada's 

high level nuclear waste to achive compliance with a quality assurance standard specified by goverment 

regulators.

This report details the form of documentation products produced by TfeXspec and all required inputs. It 

discusses the processing that TfeXspec uses to convert input into final products. The method of ensuring 

consistency between products is reviewed. Instruction is provided for operating T^Xspec using a graphical 

user interface. The significance of the work is discussed and directions for future development are suggested.

Some of the requirements of TfeXspec are continuing to evolve. As such, the development is of necessity of a 

prototype, or spiral model, nature. This report acts as a  status report on the development of T^Xspec and 

provides a reference for both users and programmers.
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1 Introduction

The Deep Geologic Repository Technology Program (DGRTP), administered by Ontario Power Generation 

(OPG), is charged with developing technology to deal with Canada’s high level nuclear waste. Atomic Energy 

of Canada Ltd (AECL), as a major contractor to the DGRTP, has accumulated considerable experience 

developing computer programs to model a deep geologic repository for used fuel [8, 9|. These programs 

require software of demonstrably high quality to support results presented to the Canadian Nuclear Safety 

Commission (CNSC) and the public.

In 1999 the Canadian Standards Association (CSA) adopted a  standard (CSA N286.7) [4] for the development 

of nuclear safety related computer programs, a  scope that included many DGRTP models. While the 

software development process used previously was considered robust, it required refinement in order to 

achieve compliance with the standard.

The T^Xspec project seeks to address the issue of compliance with the CSA standard in a general way. The 

objective is to develop a tool to support a compliant software development procedure while imposing a min­

imum of additional overhead. The tool must support the use of diagrams and/or graphics and mathematical 

notation. While TfcjXspec is optimised to meet the particular requirements associated with modeling the 

disposal of Canada’s nuclear fuel waste, it is hoped that TfeXspec will find more general usage.

1.1 Problem Definition

The principles of the CSA N286 standards require that

•  All software products be subject to a  review by qualified staff.

• Genealogy of products be preserved and

• Ownership of products be clearly defined.

To adhere to these principles, products must be clearly delineated and controlled. Where multiple products 

share common components, this can become difficult to achieve. For example, the same mathematical equa­

tion might appear in the theory manual, requirements specification and design documentation. The equation 

may have been developed by one author, the requirement specification by another and the design documen­

tation by someone else. Tracking this relationship requires that the equation be maintained separately from 

the products that reference it.

I
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The requirement to document the INROC [16, L7] computer program in a CSA N286.7 compliant manner 

has led to the development of the TfeXspec Computer Aided Software Engineering (CASE) tool. I^Xspec 

implements support for software development methodologies used in the development of INROC documenta­

tion, including requirements specification, design description and manuals. TfeXspec is designed to allow for 

enhancements handling other software development products outlined in CSA N286.7, and may be expanded 

to include other methodologies (including object oriented approaches). It is intended to be sufficiently flexible 

to permit enhancements to include other phases of the software development life cycle.

1.1.1 Commercial Tools

Several commercial CASE tools have been examined, including Dec Design [6], Graphical Designer[l|, Software 

Through Pictures[ll, 27], and Teamwork[3[. Each of the examined tools was found to be deficient in one or 

more critical areas:

• Lack of support for scientific and mathematical notations. The nature of the models demands that 

mathematical notations ( e.g., Ai[t) =  /„* [ i^ w(r)]<fr ) be permitted in specifications, including 

diagrams.

• Insufficient accountability. The principle of ownership and accountability for products is not strictly 

enforced. While a record of who updated products is often kept, the process control is often inadequate. 

For example, anyone who shares a data dictionary might be permitted to update any entry without 

regard to individual ownership of particular entries.

• Assembling large products from smaller components is not adequately supported. In the experience 

accumulated with the INROC program and it’s predecessors [18], many software defects were found to 

be the result of transcription errors between products.

•  Insufficient consistency checking between products.

1.1.2 Yourdon/DeMarco Methodology

TfcjXspec is based on the Yourdon/DeMarco structured analysis methodology [5,30] for software development.

Many models have, to date, been described using a  modified Yourdon/DeMarco methodology [15{. Although. 

0 0  methods would perhaps be more appropriate for some models, priority is given to the more common 

structured analysis methodology. Products associated with this methodology are:

• Data flow diagrams (DFDs),

2
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• Process descriptions (mini-specs),

• Structure charts,

• Module design descriptions (Design Specifications), and

• Data dictionary listings.

Data Flow Diagram (DFD)s and Mini-specs comprise the requirements specification, while Structure Charts 

and Design Specifications specify the design. Data dictionary listings may be separated into requirements 

and design, or combined into a single product.

Although Object Oriented (00 ) analysis and design is appropriate for many software applications, there are 

still applications for procedure/flow based software. In particular, some models which are basically linear in 

structure, including many scientific models, are best described using non-00 techniques.

1.1.3 Design Specifications

Module design descriptions form an engineering blueprint for code [20,24[. A programmer serves analogously 

to a construction tradesman, who implements the design. This philosophy has resulted in design documen­

tation which closely parallels the final code or pseudo-code [19[. The design specification and compilable 

code can be sufficiently similar that creating and maintaining both can be an inefficient use of resources. 

The two must also be closely monitored to ensure that they are synchronized. The duplication of effort must 

be reduced and the chance of inconsistency between products must be addressed.

1.1.4 Experience with Software Quality Control

Many models and associated programs are most clearly specified using mathematical abstractions. While it 

is possible to express A* (t) =  /„* [F‘n {t ) +- ApAp (r) — F °UT (r)] exp (—A4 (t — r)) dr in plain english text, 

it is much more convenient and expressive to utilize the mathematical notation. It is therefore imperative to 

support the use of this kind of notation in software development products, including requirements and design 

specifications, as well as manuals and other documentation. The transcription of mathematical notation has 

proven to be error-prone [18], and must be minimized.

The relationship between Requirements and Design leads to other common items between their specifications, 

as they are different expressions of the same system. For example, a requirement specification might specify 

a ‘density’, denoted as ‘p’, with physical units the design might then specify a real variable ‘rho’ with
»|w qnww ofrfryiKtft’po atwl ftpyytp ftnn Many wmmorruot CASH toola mointom a <v>mnwn H ata Piintionnry  try

3
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handle some of this overlap between Requirements and Design. This approach, unfortunately, can compro­

mise the principle of responsibility for products. In an environment where the genealogy of products must 

be known, sharing a common Data Dictionary must be carefully controlled, or multiple data dictionaries can 

be used. In the past, DGRTP has used multiple data dictionaries, but this has led to transcription related 

defects, and a propensity for dictionaries to fall out of synchronization. In addition, any attempt to merge 

dictionaries has had to resolve duplicate entries.

For the models implemented for a single environmental assessment, AECL invested over $1 million to verify 

software by unit testing [18]. The result was far from encouraging. The contractor (Science Applications 

International Corporation) found many defects in the documentation and transcription between products, 

but nothing that could materially affect results. An embarrassing number of defects was reported.

The format of software documentation may have a much shorter lifetime than the software itself. Docu­

mentation for some long lived Fortran modules have been published in Mass-11 (a word processor that is 

no longer supported), WordPerfect, MS-Word, and others, all with differing styles. Software supporting a 

single study has been published in several different formats. This experience suggests that the content of 

documentation should be separated from the presentation; the information should be collected independently 

and assembled according to the current format in use at the time of final publication.

Attributing ownership and responsibility for products is a basic principle of the CSA N286 standards. In 

order to effectively reuse common information, while remaining faithful to this principle, it is helpful to 

collect, in very small pieces, information used to assemble software products. The dependencies between 

products and components are easier to manage if the shared information is not contained in large packages. 

Keeping the granularity of components very fine also allows ownership to be tracked, without assigning 

ownership to more than one individual.

Verification of consistency between software products has been a costly and error prone procedure [18]. The 

number of products has been high, and verification has not been sufficiently automated. If a  high granularity 

of components is desired, then automation is clearly required.

1.2 Objective of the Study

The objective of this study is to develop a tool to assist in the development of software and associated 

documentation compliant with the CSA N286.7 standard [4]. The tool must address some of the deficiencies 

observed in commercial CASE tools which make those tools difficult to deploy for the development of software 

that implements mathematical models.

4
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1.3 Significance of the Study

The IfeXspec tool described in this report is a stepping stone to compliance with the CSA standard for the 

development of nuclear safety related computer programs. This compliance is expected to be required to 

support future licence applications to the CNSC.

The tool offers a viable CASE capability for computer programs which are best specified with intensive use 

of mathematical notation.

1.4 Limitations

TfeXspec is a prototype. Many features in both the underlying technology and in the usability remain to be 

addressed. Some of the requirements of T^Xspec are continuing to evolve. As such, the initial development 

is of necessity a prototype, developed using a spiral model. This report is a snapshot of the current state of 

TfejXspec development.

Currently, T^Xspec can only generate design documents for Fortran-77 code. In the next stage of develop­

ment, this will be expanded to include some Fortran-90 extensions, including 'modules'. In the future, this 

is expected to expand further to include other languages.

The Graphical User Interface (GUI) is in an early stage of development. The editors are not sophisticated, 

with no search-and-replace capability. Development of graphical products is based on non-graphical editors 

and no preview capability has been implemented. The system is usable and effective, but there is still room 

for development and further research.

The system has not yet been integrated with a  secure configuration management system. Effective sharing of 

data and meaningful software audit capabilities await this development. This could be expanded to integrate 

with a change control system.

The data processing and the GUI are currently both run on the same machine. A client/server model might 

be an important development in the future, assigning the compute and I/O intensive processing to a server.

1.5 Related Work

Aside from commercial CASE tools, the work of Wieringa [29] is notable. The Toolkit for Conceptual Mod­

eling (TCM) is implemented to support the Toolkit for Requirements And Design Engineering (TRADE). 

This tool generates several different diagram types and even performs some consistency checking of data Bow
 *.!      .......  - , i . .   /r rv rrv  v r\r  ..... j  __*. u  J i—___uingiaitta. wututkuuoiictjt nuc ojotcui tuuo u u x j  vu  ( u t t tA  //A*ttuiutn*ot uuco uut auct(ua<ict^ uouuw uiakur
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ematicai Dotation and does not integrate well with an acceptable Data Dictionary. Even so, a modification 

of TCM may provide a useful interface for TfeXspec.

Also a possibility for a drawing interface, ETj^Xcad [14] provides a GUI capable of handling math-centric 

ETfeX [13] labeling, but would require some modification. Like TCM, ET^Xcad is also a single platform tool, 

running under Microsoft Windows (MS-Win).

Another CASE tool which uses Java as a front end is the ArgoUML [22] design tool. ArgoUML is exclusively 

an object oriented tool. The interface is mature and allows the user to interact directly with diagram 

components. Since ArgoUML is an ‘open source’ project, the code is available.

IfeXspec is built on the ETfeX foundation with a pair of significant extensions. The Noweb [21] system 

for Literate Programming is used to separate module Design Specifications and compilable code. Graphics 

extensions suitable for the generation of diagrams are provided by the xypic [23] package.

1.6 Notations

l£Xspec input files are ASCII files, organized as ‘field: value’ pairs. When specifying the content of these 

files, the following notation is used:

FieidName: description of value

The ‘description of value’ is contained within delimiters as follows:

• > required field, may appear only once<

• >required field, may appear more than once<

• >-optional field, may appear only once-<

• ^optional field, may appear more than once<

Where sets of ‘field: value’ pairs are grouped, the group is named in bold type within brackets for later 

expansion. The same delimiters are used. For example: >[group name[< specifies a group of fields which 

is required and may appear more than once.

These delimiters are used rather than the more conventional bracket/brace notations to allow- for non- 

ambiguous delimitation of T£X content, which uses brackets and braces.

6
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1.7 Organization of the Report

The remainder of this report is organized as follows. The underlying technology of T^Xspec is detailed in 

Chapter 2, including the requirements, design, and various file formats. The user interface for 'IfeXspec was 

implemented separately from the underlying processing and is detailed in Chapter 3. Chapter 4 offers some 

concluding remarks and suggests some directions for further development. Appendices contain sample code 

listings and examples of the longer T^Xspec inputs and products that are not fully shown in the text. The 

final appendix provides instruction for installing T^Xspec.

7
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2 Specification and Design

2.1 The TgXspec CASE Tool

2.1.1 Requirements Specification for TgXspec

The T^Xspec application is based on the following requirements:

• Assemble user inputs to generate consistent publication quality Data Flow Diagrams (DFDs) and 

Process Specifications in a modified Yourdon/DeMarco format. This includes support for leveled’ 

diagrams [30{, which allow a ‘parent’ process to be decomposed in a ‘child’ diagram.

• Permit the use of composite data flows on DFDs. Break composites as required for a child DFD or 

Process Specification (Mini-spec).

• Ensure consistency between the data Sows shown on the DFDs and Mini-spec.

• Generate Structure Charts and Design Specifications.

• Ensure consistency between the flows on the Structure Charts and the Design Specifications.

• Ensure consistency between the Design Specifications and executable code.

• Permit the use of mathematical notation in all products.

• Allow sharing of mathematical formulae between products.

• Permit ownership of products to be tracked and reported.

• Allow components under development to reference other components from a variety of sources. Stable 

libraries of components should be supported as a default, which new components under development 

supercede.

• Support the use of Fortran as a target implementation language.

• A user interface must be provided that allows users to interact with TfeXspec in an intuitive way. The 

interface should require minimal training before a user becomes proficient.

• Information to be processed by T^Xspec is assumed to have a long lifetime, perhaps exceeding that of 

TfeXspec itself. The information must therefore be stored in a format suitable for later processing by 

other programs, or perhaps the human eye.

• A ‘batch processing’ option must be supported that can capture and log processing details.

• Learning curves for both users and implementers should not be excessive. Maintenance expertise should 

not be difficult to recruit or train.
8
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•  Coding languages, libraries and tools should be freely available.

• The system must be portable between computing platforms. Although the desktop environment is 

dominated by MS-W in , being locked to any single system restricts deployment options and reduces 

the number of potential users. Also, if the application were divided into client and server portions, the 

server environment is likely to be more heterogeneous.

Some preferred attributes of TfcjXspec are not required in an absolute sense:

1. The application should run in Reasonable' time on common desktop computers. This is a difficult 

requirement to quantify, since the term Reasonable’ is subject to interpretation and what is common 

on the desktop differs in time and location. Even so. it can be said that a responsive application is 

preferred over the alternative and that some design effort can reasonably be applied to achieving the 

best possible performance.

2. The implementation should be maintainable. Code implemented in an uncommon language is more 

difficult to maintain, as programmers are less likely to be familiar with it.

3. There should be a migration path to allow a gradual transition from existing methods. The ’cold 

turkey’ implementation of new tools is rarely well received. A pilot project style of implementation is 

preferred, as it allows operational difficulties to be dealt with before a  large commitment is made.

2.X.2 Architecture of TgXspec

TfeXspec’s GUI is discussed in Chapter 3, which captures interactions with the user. Most of this interaction 

consists of displaying and manipulating ’component’ files, which form the inputs for the TfejXspec scripts that 

select components and assemble them into products. These products are primarily BTfeX [13} or Noweb [21] 

input files, which can be post-processed to produce output suitable for viewing, printing, or compiling. While 

these outputs may be viewed as being intermediate, they are intended to be retained, as T^pCspec places 

commentary in them to record the details of TfcXspec processing.

While the GUI is a convenient way to construct components and initiate processing, it can be bypassed if 

required. The components can be generated by any means that can generate an ASCII output file, including 

a text editor. More importantly, the processing can be controlled by any means that can initiate a process, 

with no requirement for interaction with a GUI. When processing many components, or when a log of 

processing is required, this ’batch’ style processing is a  useful alternative.

9
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Neither the T^Xspec scripts, nor 

the GUI can display or print the 

products. Figure 2.1 indicates 

that an intermediate script, which 

is intended to be edited by the 

user, initiates T£Xspec to pro­

duce the product files, then con­

trols post-processing as appropri­

ate. This flexibility allows the 

user to integrate T^Xspec into ex­

isting procedures. For example, 

if a static code analyzer such as 

Floppy [2] is in use, it can be ran 

automatically on code as it is gen­

erated. Interaction with a version 

control system might be desired, 

or the user may even wish to com­

pile code as it is generated. Al­

ternatively, processing that is not 

needed can be removed, such as removing documentation generation (including processing) until the 

code is stable.

2.1.3 Design of TgXspec

All input files for l£Xspec are human readable. That is, they are in ASCII format, organized in ‘Label: 

value' pairs, which is intended to ease visual interpretation. The input files can be created using a standard 

text editor and reviewed easily due to the intuitive syntax, without the overhead of an elaborate interface.

A more sophisticated interface for handling l^Xspec files, which can be large in number, has been developed. 

Still, the ASCII format files can be edited or read by readily available tools and do not require TfeXspec 

programs to interpret.

In order to support sharing of equations and data definitions, while tracking ownership and responsibility 

for content, l^Xspec supports a  fine granularity of components. Components are tracked independently by 

placing each in a unique file which is mapped by the file name to the name of the component and by the file 

name ‘extension' (in the tradition of MS-DOS or CP/M) to the type of component.

10
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Figure 2.1: Schematic view o f  the  IteXspec architecture
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TJjjXspec components, with associated file name extensions, are:

• Requirements Data Dictionary entries (,rdd: Section 2.2.1),

• Design Data Dictionary entries (.ddd: Section 2.2.2),

• Equations (,teq: Section 2.2.4),

• Process Specifications (.ms: Section 2.3.2),

• Design Specifications (.ds: Section 2.3.3),

• Structure Charts (.sc: Section 2.3.4), and

• Manuals (.tex: Section 2.3.5).

In order to share components between individuals and projects, the location of these files is flexible. A ‘search 

list’ provides a list of directories to be searched sequentially for component files. This is often referred to as 

a ‘PATH’. A different ‘search list’ can 

be provided for each component type 

in a file named ‘.TeXspecrc’, as shown 

in Figure 2.2.

This mechanism is intended to be 

supplemented in future versions of 

TyCspec. It is intended that compo­

nents should be ‘installed’ in a  con­

figuration management system for fu-
r  _  ii j  j  Figure 2.3: Example .TaXapecrc file, specifying search lists by compo-ture reference. Once installed, depen-

nent type
dencies between components would be

monitored to ensure that the creator of a product is not surprised by a  change in his product caused by 

a change in a referenced component (a ‘sub-component’) for which someone else is responsible. For the 

moment, however, the directory search list meets the requirement, allowing components to reference other 

components from a variety of sources. This mechanism will continue to be supported as a ‘working area’. 

That is, the ‘search list’ will be set up to specify that working directories be searched first, followed by 

libraries under the configuration management system.

Component files are each assigned a version of format ‘NNA.’, where ‘NNT is a  two digit integer indicating 

the installation number and ‘A.’ is a  single character ‘draft letter’ indicating changed versions between 

installations. This corresponds to the scheme used at AECL to configure software versions manually.

11

.M : gn \ ia 0003 \ m i \

. caqt i:\ut^~H04\aaii(l«\Mal«i\f«000)\lfi»U«MV
Kt\uf%~MM\aMfl4\B^9aa\v«c000a\TMEa»«a_fMMtUqi»tMM\ 
st liOOiwif 1 nOfTTiMpiin mwl

.dat igniMrA
« t\M tjiaU p> U A t\oM O a\Q )|IB \ndM )\

st \u f» ji04\oBiit»| Vt>a | ia\Kirt0MU«wc\flsitg ip«o\

*t\sfc*aflftsUpsUAt\aot01\C&ftt\ooaoMiUfiaV 
Ups Unt\oo4C2 \Cnf03 \fetoads UasV 

•t\aM sjM«Up*\lnt\ooM 2\Cnfaa\Maoo*UiMt
.MMt s t\u f%  » M \aw g U \ii» > p \is9 0 0 3 \8 M ty < D \

m\n» tftK\zm\&v\cc«oa\vit\vo»Q\diati«nscyV
Wt\A*~iMicUVA\Z^\CC402\Vlt\va209\41 o i l  antsy \oo«\

.cMdt st\uf#jMM\aM*&t\MMl9kVras000SN«M*\
st\ug^j»04\oawgn\M^yaVssK000a\t—psc^gwstX—|ui i —rn «B\

■ Ht st\yl#jtM \BorfH\iiMpi\ iM0003\stw»tiiiiiim t\

.dffdt
s t \ y f # j i 0 < \ psr f H M ^ H B \w » 0 < 0 a m iM » s to w itM S ttR BsM M w V 
s t \ u ( # j a 0 4 \o s i ( i t \M M a s \w M 0 S U n m \D tu n o « ta tn i \

Reproduced with permission of the copyright owner. Further reproduction prohibited without permission.



www.manaraa.com

To keep track of the components used to assemble a TfeXspec product, the EfffeX input files generated 

by TfeXspec modules contain commentary that identifies all referenced components and the version of

the TfeXspec module that assembled■it— r im l l j  by uu— 1> —— b t t i r  m c  i t  
wtprc p w ru r t  by ei\Bf#-jM04\c«rfif\msMe\i*iOoe«\btA\4 MWV»e.»l m f ln ib r  

is  u t» ts a  son
s$ \oe^ M w d « \eo n fiiv m m e\w eeeo « \b in \d * i» t^* .p i oar

mt/m *  «br/I»/I^/CC40a/Vlt/V0a04/dlotAoniy/imt/«lM  iSbl o u  
Vt/Wahr/ZM/Z^/Qe«ea/VltyvoaM/tfUCion«y/as4^MBMa.dM o u
Wt/U»~*hg/XU/Iab/CC402/Vlt/V0a04/<latAo«*«Y/oo4/«nbl— iliSrt OU
«t/u»*W/xm/xi9 /ee«oa/vicyvo304/«ta«iaMcy/oa«/M«.Md ou
*rZUe™al»/IWlu/CC40aVVl,t/V020</dt«l«na*yZeo«/b*he*.dbS o u  
• t  /m tT ritf/XM/Xu/CC40amc/V02M/«lotloa«y Zoo«/iMHiCa.
«t mtTMir/tm/zu/cc4oamcAoaM/«utt«Mcy/oM/i 

Mtr/XM/t^/CC40a/Vlc/VQae4/41ctlaaasy/ao4/i 
Vt/W*tf»/XWUb/CC40a/VleA020«/Si«tieeeey/ea4/i
«r/Wahr/ISS/t^/ceM9mcA0304/«iaci«nMyZoo«/Ms.bM ou
«:/Us'a»ir/Z>S/Ẑ /CC402/yik/V030S/4lAUanuy/ao4/ray.d*S OU 
«t/WW/XSS/T /̂OC402/Vle/V030S/tfLa«l«M(y/«v3/iwIaiS.bbS OU

01C
01C
oie
oie

them. A date-time stamp is included 

and is also placed on the generated 

product (in the upper left corner) to 

uniquely associate the ET^X file with 

the associated product. By retaining 

the ET£X file, it is possible to audit 
Figure 2.3: Top of a  I/TfeX Hie generated by TfeXipec, ihowing version* ^  content of any product. This is 

o f com ponents demonstrated in Appendix B.

Each formatted product has an additional configured component. The ETfeX ‘class’ .els file used to specify 

the format of the product (in particular the page header) must be installed into the ETfeX system that 

TfeXspec will use to produce products. At the upper right corner of each generated product, the version of 

the 'class’ file is printed.

As discussed in Section 1.1.4, minimal formatting information is stored with the TfeXspec components. 

Formatting is a function of the processing of the components. The hope is that as documentation formats 

evolve, the critical content of the components shall not be rendered obsolete.

Many scientific models benefit greatly from the ability to incorporate mathematical notation in their speci­

fication. One of the requirements of TfeXspec is to support such notation in all products. To be compatible

with the ‘human readable' design decision, a notation is required that stores such information in ASCII 

format. This information must then be translated into a  flexible presentation format.

Since the Off^X system is already mature and offers leverage toward meeting the requirements stated in 

section 2.1.1, TfejXspec produces documentation via ET^X.

To keep code synchronized with associated documentation, a literate programming [10, 12] methodology is 

ideal. A single file is used to generate both a Design Specification and compilable code. Fortunately, several 

systems already exist to support this method in a environment. The No web system was selected 

because it is not sensitive to programming language, allowing TJjjXspec to evolve (in the future) to handle 

languages other than Fortran. An additional benefit of adopting Noweb is that much of the syntax for the 

Design Specification file (Section 2.3.3) is defined in Noweb, relieving T^Xspec of the requirement to define 

such syntax.

Components are processed by T^Xspec modules according to the How specified in Figure 2.4. Users of

12
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TEKspec provide content in components in the 'Shared Components’ and 'Product Definition’ categories, 

which together comprise the T^Xspec inputs. The 'Shared Components’ are intended primarily to be refer­

enced by the ‘Product Definition’ files.

The inputs are processed into ‘Products’ by IfcXspec. These products are listed in Figure 2.4 and correspond 

to the products defined by Yourdon [30] and Page-Jones [19], plus the Fortran code. Note that the output 

from TfcXspec is not publishable (or compilable), but must be post-processed by BTfeX and/or Noweb to 

produce final products.

Shared
Components

/  /  '  
lilnKamCMfUl) ffcniaao.pt)

Product

Figure 2.4: IfeXapec flow. Indicating the  m ajor scripts, w ith th e  relationship o f  inputs and outputs.

2.1.4 Implementation Language

The main TfeXspec processing is performed by modules which have been implemented in Practical Extraction 

and Report Language (PERL) [28]. The selection of PERL was based on a number of factors:

e it does not conflict with the requirements stated in section 2.1.1 and 

• it has sufficient flexibility to act as a general purpose language.

For the purpose of developing a  user interface, PERL is not as good a  fit. Although a  simple GUI can be 

implemented in PERL using existing libraries, the required GUI is not sufficiently simple. The TfejXspec GUI 

is implemented in Java. The selection of Java was based on a number of factors:
13
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•  it does not conflict with the requirements stated in section 2.1.1 and

• the associated ‘Swing’ [7] library can be used to develop a sophisticated GUI.

2.2 Application Shared Components

Some TfcjXspec input flies are intended to be shared. That is, they are referenced by other input files (see 

Section 2.3). This relationship is illustrated in Figure 2.4.

2.2.1 Requirements Data Dictionary

Although a Data Dictionary listing (Section 2.2.3) is available as a stand-alone product, the primary use of 

Data Dictionary entries is to be referenced by other components such as Mini-specs or Data Flow Diagrams.

Each entry is contained in a file name.rdd where name is the argument in the 'Marne:’ line.

Syntax of Requirements Data Dictionary (.rdd) file

Marne: > short name in ascii format - minimal for unique identification<
LabelName: >name to appear in diagrams (if different)<
MathName: >-name using mathematical notation entered in DTfiX formats
LongName: >descriptive name in ascii format - up to a sentence<
Version: > version number for tracking history - appears on listings<
Project: > project identifications
Subproject: > sub-project identifications
Author > author's full names
Date: >date that the entry was writtens
Implementen >full name of person who input this entry into the systems
ImpIementDate: >date that the entry was entered into TeXspecS
Reviewer >-full name of reviewer<
ReviewDate: >date of reuieuK
CompositeOf: >-comma delineated list of other Requirements Data Dictionary 

entry ‘Name’s i f  the entry is a composite o f other entries-<
PhysicalUnits: >-SI units enclosed within square brackets-<
DataType: >-descriptive data type e.g.t ‘integer’̂
Dimension: >- dimensioning information-<
Description: >full description - up to a paragraphs

An example of a Requirements Data Dictionary entry is shown in Figure 2.5. The example is a ‘composite’ 

entry, composed of several other entries. Mote the optional ‘LabelName’ field is used to produce labels on 

Data Flow Diagrams which differ from the ‘Marne’. TfcjXspec requires that name.rdd be a  valid file name, 

but the dash in the ‘sp-Alpha’ might create an illegal name.rdd. Using ‘LabelName’ prevents the potentially 

offensive syntax from appearing in the ‘Marne’ field, but diagram labels can contain the dash.

14
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»-__ spalph
LabelName: sp—ALPHA
KathKaae: sa^Ied_\slphs
Lon^Um: Sampled par masters for alpha radiolysis
Version: 018
Project: CC4
Submodel: inroc
Author: S.K. Oliver
Data: Oct 4, 2000
Iaplasmntar: s.X. Oliver
I^lamantDate : Oct 4, 2000
Ca^oaiteOf: AALPHA>AIfCOP(ALPHDO,ALPHTX,BALPHArCALPHAtDALPHA>XALPHA>fALPHA>MCIALPH,S1DHOA
Description: Sampled parameters for calculation of fuel corrosion rate 

due to alpha radiolysis of water.

Figure 2.5: Example Requirements D ata  D ictionary file.

2.2.2 Design Data Dictionary

Much like Requirements Data Dictionary entries, Design Data Dictionary entries may appear in a Data 

Dictionary listing (Section 2.2.3), but their primary use is to be referenced by other components such as 

Design Specifications or Structure Charts.

A Design Data Dictionary entry may reference a Requirements Data Dictionary entry via the ‘Requirements1 

field. If this is done, any missing fields in the Design Data Dictionary entry will default to the value found 

in the specified Requirements Data Dictionary entry. This is particularly useful to avoid transcription and 

synchronization problems with the ‘MathName’ and "Description’. Fields which are specified in the Design 

Data Dictionary supercede any inherited defaults.

Currently, the ‘CompositeOF field is supported in the Requirements Data Dictionary only, and is unsup­

ported in Design. As T^Xspec evolves to support programming languages with more advanced data structures 

than Fortran-77, this will probably change.

Each entry is contained in a file na.me.ddd where name is the argument in the ‘Marne’ line.

The dictionary can specify a  constant value, or a ‘condition’ may be placed on the value. A "condition’ is 

interpreted as a a "precondition’ to modules for which the variable is used as input and a  "postcondition’ to 

modules assigning a value to the variable. This is usually a physical limitation on the range of valid values.

15
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Syntax of Design Data Dictionary (Add.) file

Name: > short name in ascii format - minimal for unique identifications
LabelName: yname to appear in diagrams (if different)-<
MathName: >-name using mathematical notation entered in BT^X format*
LongName: >  descriptive name in ascii format - up to a sentences
Version: > version number for tracking history - appears on listingsS
Project: > project identifications
Subproject: >sub-project identifications
Author: > author’s full names
Date: >date that the entry was writtens
Implemented >full name of person who input this entry into the systems
ImplementDate: >date that the entry was entered into TeXspecs
Reviewer >-Jull name of reviewer-i
ReviewDate: >-date of review*
Requirements: y  ‘Name ’ of corresponding Requirements Data Dictionary entry*
PhysicalUnits: y S I  units enclosed within square brackets*
DataType: >data type suitable for program design in target languages

Dimension: > dimensioning informations
File: y for shared (COMMON) variables - file to contain definition*
Common: yname of Fortran COMMON block to contain data*
Value: y  value if  constant*
Condition: y  limitation on value, used as 'pre- ’ or ‘post-condition’*
Description: >full description - up to a paragraphs

In cases where the variable can be directly mapped to a Requirements Data Dictionary entry, the 'Require­

ments’ field can be used to specify the mapping, and any common fields are inherited from the Requirements 

Data Dictionary (unless overridden here).

An example of a Requirements Data Dictionary entry is shown in Figure 2.6.

Hama: AALFBA
MathNama: a_\alpha

rit coefficient a for alpha radiolysis
Version: 01C
Project: CCS
Submodel: XMWC
Author: S.C. Oliver
Date: October 25, 2000
Xavlesmnter: S.K. Oliver
I^lamantDate : October 25, 2000
DataType: double
Dimension: scalar
File: SfALFH.XMC
CcHBon: SFALPH
Description: bpirical fit coefficient '?a$ ’ for alpha radiolysia, 

used in the calculation of of the degradation rate per

Figure 2.S: Example Design D ata  D ictionary file.

16
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2.2.3 Dictionary Listing

Data dictionary entries are incorporated into other products, but can also be assembled into a stand-alone 

product. TfeXspec provides a module ‘formatDD.pl’ which provides listings of Data Dictionary entries. It can 

also provide a cross-reference, showing the Process Specifications (Section 2.3.2) and Design Specifications 

(Section 2.3.3) in which they occur (optionally colour coded to indicate the direction of Sow).

A sufficient number of fields exists to make a  complete listing impractical to tabulate on a single page. To 

ease this problem, formatting on "legal” size sheets is supported, and the default orientation is landscape. 

Even so, the user is obliged to select a subset of the available fields for listing. The user may also specify 

the width of particular fields. Usage is shown in Figure 2.7 and a sample output is shown in Figure 2.8.

The ‘width’ fields are specified in BTfeX-style measures including units (e.g., ‘O.Sin’). The "xref’ option 

produces a cross reference column and the ‘Sow’ sub-option causes the cross reference to be colour coded to 

indicate direction of flow.

Usage: fornatCD.pl
R|D|M •... "R'aquiroaaant, "D"esign, or "IV'erged
[lines-nn] #... est max liras pox page
[chars*nn] t... esc chars/inch
[capsmm] •—  aat CAPS/inch
[portrait]
[description[:width]]
[xraf[:width][:flow]]
[longnaao[:width]]
[mathname [ -.width] ]
[version[:width ]]
[project]: width] ]
[submodel[:width]]
[author]:width]]
[date [: width] ]
[iag>laamntar [: width ] ]
[liqil ssmntdata [: width] ]
[reviewer[:width]]
[reviewdate[:width]]
[physicalunits [:width]]
[datatype [: width] ]
[dimension [: width] ]
[file [: width]]
[common[:width]]
[value[:width]]
[requirements[:width]]

>f ileout.tex

Figure 2.7: Usage o f  fonnatO D .pl.

17
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Name Version Long Name Symbol Description Common Appears in
ALFCOF 01B Scale factor for alpha dose Estimates uncertainty in piece- 

wise linear fit of alpha dose as a 
function of time a(t).

SPALPH ALPHOS

ALPHDO OIB alpha dose to used fuel surface a values of alpha dose rate to the 
surface of used fuel

SPAIPH ALPHDS

ALPHRE 010 release rate from alpha radiolysis release race from used fiiel per 
container from alpha radiolysis

ALPHDS

AREABF OIB area of the backfill B , area of the backfill VLGDEP
AREADZ OIB area of the damaged zone B z area of the damaged zone VLGDEP
BALPHA OIE Fit coefficient b for alpha radiolysis fc, Empirical fit coefficient ‘6’ for 

alpha radiolysis. used in the cal­
culation of of the degradation 
rate per unitsurface area of fuel 
d .w ^ r t . c t + y r - i o * *

SPALPH ALPHDS

BKFRAR 010 frac of vault with backfill a ,  s i r , , i s fraction of vault area containing 
backfill

VARLVG VLCDEP
VLTDEP

BUFRAR 01D frac of vault with buffer A s s ITb / S fraction of vault area containing 
buffer

VARLVG VLGDEP
VLTDEP

EALPHA OIE Statistical parameter alpha radiolysit I Based on experimental data cor­
relating alpha dote to rate of 
fuel corrosion. Used to estimate 
the standard deviation of pre­
dicted corrosion rate.

SPALPH ALPHDS£  (lot a,- 10*0)'

EXPONA OIC log(predicted alpha corrosion rate) logoff) base 10 log of predicted corro­
sion due to alpha dote a t  a func­
tion of rime

ALPHDS

FALPHA QIC Mean experimental alpha radiolysis EgO Mean experimental alpha radi­
olysis

SPALPH ALPHDS

Figure 2 .8 : Portion  o f  a  D ata Dictionary listing, including a  cross reference column.
Inpu t and  o u tpu t d a ta  Sows are colour coded green and  red, respectively. Local variables are black.

2.2.4 Equations

Equations are held in individual files, with version information similar to other TfeXspec components. These 

files can be inserted into BTfcX documents using the \tnput{} macro. A slight modification to the usual 

l£Xspec file format stores T^Xspec information in comments, as shown in Figure 2.9.

It has proved convenient to generate these files using a PC/Macintosh product called MathType, which 

adds additional comments to the file, containing encoded information which allows the equation to be

18
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used in PC-based word processors, 

as well as BTfeX, as shown in Fig­

ure 2.9. The comments generated 

by MathType are ignored by ET&X, 

but can be imported back onto the 

personal computer for inclusion in 

word processing documents. This 

decreases the possibility of inconsis­

tency between TfeXspec documenta­

tion products and related technical 

reports, memoranda, etc. that ref­

erence the same equations.

Although the use of MathType is 

optional, many users prefer the use 

of a graphical equation editor over 

ASCII input of ETfeX math syn­

tax. Figure 2.9 illustrates the use 

of the graphical editor and shows 

the ASOT equivalent. Other graph­

ical editors are available, including PI*ure 2 9: An exame|e &»uatton Wo*,hown in AScn format and
being edited  by M athType (bottom )

iQXaide, which is available without

charge horn the manufacturers of MathType (but lacks the word processor interface).

The syntax for the Equation file is as follows:
Syntax of Equation (.teqj file

%Name: >short name in ascii format - minimal for unique identification<
%LongName: > descriptive name in ascii format - up to a sentence<
%Version: > version number for tracking history - appears on listings<
%Pro]ect: [> project identification<
%Subpro]ect: >sub-project identification<
%Authon > author’s full name<
%Date: >date that the entry was written<
%Implementer >full name of person who input this entry into the system<
%ImplementDate: >date that the entry was entered into TeXspec<
%Reviewer: >~full name of reviewer<
%ReviewDate: >~date of reviews
%Description: >full description - up to a paragraph<

comments from MathType-t.

equation<

19

IK oae: Cyl l n ileiU M —e l
lIoogNaaa: coiwoctloa-dlopogoion oqoatioa (cylindrical)
I W t i a a ;  OXJt
l l n j w t :  CC4
Mufaprojacfc; XMOC
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%D*zmt Mot 5r 1999
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2.3 Application Composite Components

Some TJgXspec input files are directly associated with a final product. They typically reference the shared 

components discussed in Section 2.2.

Bach of these files is the primary input for T^Xspec processing as shown in Figure 2.4. Mote that Design 

Specifications act as both a primary input for designSpec.pl and a shared component for stmctureCha.rt.pL

2.3.1 Data Flow Diagrams

DFDs are stored by name, and are assigned a  number only when the processing script (dfd.pl) is run. This 

mechanism allows a project to be re-numbered without necessarily changing the content of the diagram. The 

output from the processing script is named according to the specified number, which is then processed by 

D-T̂ X. This naming convention is important for consistency checking, as discussed below.

Figure 2.10 illustrates this process. The diagram ‘Diagram- 

Name' is assigned number 1.2.3, which is represented as T.2JF 

in file names. Consistency checking is performed against the 

parent Data Flow Diagram (DFD 1.2) as described below.

Syntax for processes (often called 'bubbles’ when speaking of 

Data Flow Diagrams) and data stores are described by Your- 

don [30]. Of particular importance is the distinction between 

'atomic' processes (i.e., processes which have an associated Pro­

cess Specification), which are shown with double circles, and 

processes with lower level DFDs (i.e., processes associated with Figure 3.10: Dataflow D iagram  processing, 

child DFDs which decompose the process further) which are *p®cifyingthe diagram  num ber (1.3.3) a t  run  

shown with a single circle. tim e.

DiagramName.ds

dfd 1 2.tex

dfd 1 2  3.tex

| LaTeX |

I
diagram
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The syntax for the DFD file is as follows:

Syntax of Data Flow Diagram (.dfd) file

Name: > short name in ascii format - minimal for unique identifications
Version: >  version number for tracking history - appears on UstingsS
Project: >project identifications
Subproject: >sub-project identifications
Author: >  author’s full names
Date: >date that the entry was writtens
Implementer: >full name of person who input this entry into the systems
ImpIementDate: >date that the entry was entered into TeXspecS
Reviewer >-full name of reviewers
ReviewDate: ydate of revievx
Units: >-valid DTgX units of measures
Labels: > ‘math’, ‘short’, ‘med'r o r ‘long’s
>[process spec|<
^[connector spec]<
>: [datastore spec] ■<
>[flow spec]<
>- [legend spec} -<

Notes: >-annotation associated with the diagrams.

Where:

process spec =

Process o # < : 

At:
atomic

>dfd or mini-spec name 
(name may include \ \  ’ = line beaks for labeling) S  
>x,y coordinates in specified unitss 
>~fiag to indicate that process is a mini-spec-<

connector spec =

Connector
At:

> label for off-page connectors 
>x,y coordinates in specified unitsS

datastore spec

DataStore:
At:

> label for data stores
>x,y coordinates in specified unitss

flow spec =

Flow.
From:
To:
Type:
Inflection:
RelPos:
LabelOSset:

> entry in Requirements Data DictionaryS 
t> process, connector, or data stores 
>process, connector, or data stores 
>~‘static’ or ‘temporal’<
>■ curvature of armvx
>-position of label along the curve (0,1 are the ends)< 
>-offset of label away from the curve (99 = do not label)-<

legend spec =

Legend:
At:

[> ‘vertical’ or ‘horizontal’s  
>x,y coordinates in specified unitss
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Connectors are placed at the ends of arrows representing flows that terminate outside the current diagram. 

Processes, data stores and connectors are all located on the diagram by specifying fay) coordinates, in units 

selected by the user.

The specified positions are relative, but the scale is absolute. The origin will be located so that negative 

values will not be placed off the page. Distances between objects that are larger than the available drawing 

area causes the diagram to be truncated; no soiling is performed.

Flows are specified by stating the end points (processes, data stores, or connectors), the inflection of the 

curve and label location. The meaning of the values for curve inflection and label location are defined by the 

xypic [23] package. The inflection is specified as the offset from linear at the midpoint of the curve, in the 

same units as the rest of the diagram, with positive values bending up and to the left and negative values 

bending down and to the right. Label location is specified relative to the flow, with 0 being the start of the 

flow and 1 being the end of the flow, but values less than 0 or greater than 1 are permitted. Label offset 

values place the label the specified distance from the curve, with positive values being above the curve and 

negative offsets being below the curve.

T lt ls :
V l n u a t
fr a )a a tt

hM
A t:
i t a

Icoa
At:

ftm*
XL:

D ttiiM M  Ip M U tM ft o f  O m a d M ttr  
OIB
imoc-ts
t a n o  
M  Malay*
rate 2 2 , 2000 

a ta e t  f ta v a  O ilvar  
atO atat Sap 1 5 , 2000

»iulpbataV\Conoaatcat*aaa

CaoM
XL:
Cams
XL:
CaoM
XL:
CacMM
XL:
C am
XL:
C am
XL:
Comm
XL:
COOM
XL:
CaoM
A t:
Goon
A t:
Com
A t:

C aloulataW C aloia
3 .1

Caloulata\\M iaac\\AAiaaV\Caaaaatrat*aaa
3 .2 5 .3

Ad3ttat\M o d liM'Q U ogida\\C onoaBtr*tiona
3 .5

Input MOSUL 
0 . 5 , 1
Input f p n m  
0 .5 ,2
Input i p j o a  
0 .5 ,2 .5  
Input a in o r  m 
0 .5 ,3 .5  “
Input a p u o a  
0 .5 ,4
Input oyptt 
0 .5 ,4 .5  
Input nr 
0 .5 .5
Ou tp u t £57 
( .5 .5

( . 5
Output oooo a  
( .3 .5 5  "
output cam. 
( .1 .4

f lo u t
Froau Input WAIPfc
Tor CalouI>ta\\C n A o»m lttlph>ta\\C oaoantratgoaa
In fla o t ia n :  *0 .3
R alfaat 0
tabalO ffaotr -0 .1 5

flou r  f f n o n
f m t  I ip u t  fp n o o
Tat CalqulataW C oIoaim tuIph otaWConaantrattawa
X aflaotianr 0 .1  
nalPoar 0 .15
LabalOffaat: >0.15

F lout fp n o a
fr m t  Input- fp n o o
Tat S d 3u at\\5o (A m  ChloeidaW Conoantcatioaa
In f la o t ia n  r -0 .4  
LabalOffaat: 55

f lo a t
I t a :  CnlaulataV\MsnarV\Anion\VCenaontcatxa
To: A M }aet\\Se41ua-C M ocide\\C enaaatratia
l a f l  n otion  r  - 0 . (
R alfaat 0 .35
LnbalOffaat: -0 .2 7

L b y  0 0 0 0 1

Figure 2.11: Example DFD file.

N ot a ll flows are  shown. Note the use o f  th e  \ \  to  denote a  line b reak  in  th e  ‘Process’ names. 

T he ‘N otes’ are  supplem ented by generated notes from  TfeXspoc, a s  shown in  Figure 2.12.
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An example of a DFD file is shown in Figure 2.11, and the output generated by TfcjXspec and is shown 

in Figure 2.12. A complete example is contained in Appendix A.

INROC-LE mroc
Data Flow Diagram 1.43 Determine Spedation of Groundwater Version OIB
Author: Ibd Melnylc Feb 22,2000
Impiementcr: Steve Oliver Sep 29,2000
Reviewer September 29,2000

1^4J
Adjmt

Sodium-Chloride
Concentrations

KW

CCL

iCBCARB

CH1PSI
m inor-eq

‘tpm j o t

'CSUL

ICC,
CSUL

KCASUL Calcdtte
CticknvStilphate

Concentrations

Implemented by SPCGCN
equflibrium-constants = {minor_eq, KCASUL, KW}
sp-ioa *  (ipmicn, spmjcn, fprion)
gw-sperialinn *  {conc_anioiis, ISF}
conc-majoranions = {CCL, CSUL}
ccnc-aniooa > {conc_majorank)n», cone mlnormniona}

Figure 2.12: Example D ata  Flow  Diagram .

'N otes’ are  generated to  deta il th e  contents o f  any composite flow whose contents appear on the 

diagram . T he components which ap p ear on the  diagram  are shown in bold type.

TEXspec supports two types of Bows: ‘static’ (not time dependent) and ‘temporal’ (time dependent). This 

contrasts with the Yourdon [30) specification, which supports ‘data’ and ‘control’ Bows. Both ‘static’ and 

‘temporal’ flows would be considered ‘data’ flows by Yourdon. The visual presentation of two distinct types 

of flow is similar and only a generated legend (which is optional) would betray the user who redefined the 

two T^Xspec flow types for the purposes specified by Yourdon. In the future, TfeXspec may be enhanced to
Hrtw mw numKae fl/wtr H/TMM»  ta  •♦**»** ^ M iU H U l f  UW>* W4 ««>* UHMiWM W4 **«*««
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Consistency between DFDs is monitored by T^Xspec. As shown in Figure 2.10. at nui time dfd.pl accepts 

an input parameter to define the diagram number. Generated output is tagged with the diagram number, 

by including the number in the name of the file containing the generated output. The script looks for output 

from the parent of the assigned diagram number by searching for the file name containing the parent’s 

diagram number. If output from the parent diagram does not exist, then a warning message is generated. If 

a parent diagram does exist, then consistency is checked, allowing for composite Sows. The input and output 

flows on the current diagram must correspond to the flows to/from the appropriately numbered Process on 

the parent diagram and all flows belonging to that Process must be represented on the child diagram. This 

can be either an exact match, or flows on the child diagram may be contained in composite flows on the 

parent.

Parent DFD 1.4.3
Child DFD 1.4.3.2

testCCL
CBCARB

CPCARB'CBCARB ' KSC.,

PH

KSP
CUPS

CCA
CHIPS

KPl
/CC>

CSUL

CP

Xotm

-  frnjbi.Ksa.KSCKsr.KSP) 
«pp6«{PH}
cooc»mtnorentao« *  {CF.CTCARB.CHPS}

Mq,KCASUL,KW>
ip-ten K{tpcafca,fpatJca»fevioat 
|w ipwdiiton ■ ( n t j i l n —,B f}  
cooe-majonnlona** {CCL. CSUL}

Figure 2.13: C onsistency Checking o f  DFDs.
P aren t DFD 1.4.3 is shown on the left and it’s only child (DFD 1.4.3.2) is shown on the right. T he highlighted 

Selds illustrate  consistent use o f  a  composite Sow - no highlighting appears on actual ou tpu t.

Figure 2.13 illustrates consistency checking. The parent diagram (DFD 1.4.3, on the left) contains three 

Processes. Process 1 and Process 3 are represented by double lined circles, indicating that they are ‘atomic’ 

and are detailed in an equivalently numbered Process Specification. Process 2 is represented by a  single lined 

circle, indicating that a child diagram (DFD 1.4.3.2) exists, as shown on the right.

To illustrate the treatment of composite flows, ‘spmicn’ is highlighted in red and it’s components are high­

lighted in green. The child diagram (on the right) shows inputs of ‘CFTOT’, ‘CPTOT’ and TCAJl’, which is 

consistent with flow ‘spmicn’ into Process 2 on the parent diagram. Detail of the decomposition is contained
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in the ‘Notes’ section on the child Diagram. Note that ‘spmicn’ is itself a component of Bow ‘sp-ion’, which 

would appear on the grandparent diagram (DFD 1.4).

2.3.2 Process Specifications (Mini-Specs)

Process Specifications are stored by name and are assigned a number only when the processing script (miniS- 

pec.pl) is run. This mechanism allows a project to be re-numbered without necessarily changing the content 

of the specifications.

Input and output flows are specified as Requirements Data Dictionary entries. If the parent Data Flow 

Diagram (Section 2.3.1) has been processed, then the Sows are verified for consistency, otherwise a warning 

message indicates that no verification was performed. Flows in the Process Specification must be atomic, 

but the corresponding flow on the Data Flow Diagram may be composite (although this is discouraged). 

Otherwise, consistency checking is analogous to checking between a Data Flow Diagram and it’s parent.

The detail of the process is specified in free form No consistency checking is performed between this

and the specified flows. A macro is provided to allow the user to include a TJjXspec equation. The macro 

includeEquation{mme} causes TfeXspec to scan the search list for name.teq and insert the contents at the 

specified position.

The syntax for the Process Specification file is as follows:

Syntax of Process Specification (.ms) file

Process: >short name in ascii format - minimal for unique identification<
Version: > version number for tracking history - appears on listings<
Project: > project identification<
Subproject: >sub-project identifications
Author: > author’s full names
Date: >date that the entry was writtens
Implementen >full name of person who input this entry into the systems
ImpIementDate: >date that the entry was entered into TeXspecS 
Reviewer >~full name of reviewer*
ReviewDate: >~date of review*
\begin{description}

>short description<

\end{description)

\inputFlow{Requirements Data Dictionary entry}*

y_ \outputFlow{Requtrements Data Dictionary entry}*

>DTe)C description ofprocessS

An example of a Process Specification file is listed in Figure 2.14, with the corresponding specification as 

generated by TgXspec and t&gX.
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°’£

'i * •w i

Ui

o -h a

0 H

Figure 2*14: Example Process Specification*

T he input file on th e  left resulted in  the  specification on  the  right.
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2.3.3 Design Specifications

Module design documentation adheres to the concept of literate programming [10, 12j, which uses a single 

source hie to generate both the Design Specification and compilable code (the same file is also referenced to 

assure consistency with Structure Charts, as discussed in Section 2.3.4).

The syntax follows a hybrid format, with TeXspec specific syntax providing an interface with the rest of the 

system. This component is processed by TeXspec to produce a Noweb [21] input file, which is then processed 

into final products.

Noweb is a literate programming tool that permits a module to be broken down into code chunks which 

consist of blocks of KT^X commentary and corresponding compilable code. It has a simple syntax that is 

portable to most programming languages, including Fortran.

Noweb code chunks that are not referenced in other chunks are placed in the default code chunk «  « » .  

The description, declaration, "include’’, and directive chunks are generated automatically by TeXspec.

Although the generated code is not intended to be a main­

tained product, the description is replicated (as comments) in 

the generated code. The code 'chunks’ are also commented, 

by practice, to allow easy navigation when using a symbolic 

debugger.

Also carried through to the code are the variable definitions 

from the Design Data Dictionary, These definitions are placed 

next to the variable declarations. This includes the 'Physical 

Units’ assigned to each variable and allows the use of AECL’s 

unit checking program 'UNTTCK’ on the generated Fortran 

code. UNTTCK is a proprietary static analysis tool that bal­

ances physical units in each executable Fortran statement.

The actual processing of a Design Specification occurs in 

stages, as shown in Figure 2.15. The processes performed by 

TeXspec PERL scripts appear in highlighted boxes. Other 

processes are shown as unshaded boxes.

A Design Specification file is processed by 'designSpec.pl’ to produce a Noweb [21[ input file. Noweb’s two 

constituent programs 'noweave’ and 'notangle’ independently process this file to produce a IXEfeX input file 

containing the formatted specification (see Figure 2.17), and an ASCII file containing the compilable code.
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Figure 2.15: Design Specification Processing
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Noweb output contains declarations in 'code chunks' which would be printed in the specification. TeXspec 

prints a superset of this information in tabular format, so the 'cleantex.pl’ PERL script removes the redundant 

code chunks before generating the Design Specification, without impacting the generated code.

The code output by Noweb contains, by default, many blank lines which make it difficult to use a symbolic 

debugger. The PERL ‘cIeanfortran.pl’ is used to remove the extraneous blank lines.

Further reformatting of the code is up to the user. For example, it is possible to pass the Fortran through 

CERNs Floppy [2] package to reformat the code and produce a rudimentary static analysis. Most processing 

that users would perform on manually generated code can be applied to the generated code.

When revising and debugging code, it may be advantageous to eliminate the overhead of generating the 

documentation as shown on the left branch of Figure 2.15 (starting at 'noweave’) until the code is stable.

Design Specifications are checked for internal consistency between declared variables and the Fortran code. 

Since information in the Design Data Dictionary is not repeated, but is extracted and placed in the Design 

Specifications (and hence the code), these products cannot be inconsistent with the Data Dictionary.

Information that appears in both the Design Specifications and the Structure Charts (Section 2.3.4) is also 

not repeated. The Design Specification acts as the repository of the shared information that the Structure 

Charts reference so they cannot be inconsistent.

Similarly, users are encouraged to share equations in a common pool (see Section 2.2.4). Although there 

is no requirement to do so, it is helpful to keep notation consistent and to propagate changes through all 

affected products.

Since both the code and the formatted specification are produced from the same file. T^|Xspec(through 

Noweb), acquires the attributes of literate programming [10, 12] systems, including consistency of the spec­

ification and the code. Correct code documented with an inconsistent Design Specification can result in 

many software defects [18], which cannot occur with literate programming techniques.

Arguments and shared variables must have a declared direction of Bow: ‘in p u t’, ‘o u tp u t’ or ‘input,ou tput’. 

This information is reflected in tabular listings in the specification (the table for call arguments is similar to 

the table for shared variables shown in Figure 2.17). It is also used in the generation of Structure Charts 

(Section 2.3.4).

When the design specification is processed by TeXspec, the Fortran code itself is examined for internal 

consistency with the declared variables, including direction of Sow. The use of undeclared variables is 

flagged, as is the declaration of variables that are not used. TeXspec issues a warning message if variables 

designated as 'output’ Sows are never the subject of a  Fortran assignment statement, or if ’input' variables 

are changed. It is critical to have 'input’ and 'output’ correctly tagged, to ensure a  correct Structure Chart 

(see Section 2.3.4), Dictionary Listings (see Section 2.2.3) and Design Specification.
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The syntax for the Design Specification file is as follows:

Syntax of Design Specification (.ds) file

Module:
LongName:
Version:
Project:
Subproject:
Author:
Date:
Implementen
ImpiementDate:
Reviewer
ReviewDate:
Language:
Standard:
« d e s c r ip tio n » =  
t>text descriptions 
s  %def description< 
x  [argument} <

> module name in ascii format<
>- descriptive name in ascii format for Structure Charts
> version number for tracking history - appears on listings<
>praject identifications
>sub-project identifications
>author’s full names
>date that the entry was writtens
>full name o f person who input this entry into the systems 
>date that the entry was entered into TeXspecS 
>-full name o f reviewers 
>~date of revievK
> ‘Fortran-77/ ‘PROGRAM’ or ‘SUBROUTINE’ or ‘FUNCTION'S
> applicable programming standards

t .  [sharedj <

Constant: 
V [local] <

> variable with an assigned value in Design Data Dictionary^

^  [chunk) <

Where:

argument =

Argument:
Flow:
Dimension:
>- [prepost] -<

>variable in Design Data Dictionarys 
E> 'input'  or ‘output’ or input,output's 
> Dimension to override definition in Design Data Dictionarys

shared =

Shared:
Flow:

>- [prepostj -<

>variable in Design Data Dictionarys 
> ‘input' or ‘output'  or ‘input,output's

local =
Local:
Dimension:
Data:

> variable in Design Data Dictionarys
> Dimension to override definition in Design Data Dictionarys
> Initial values

prepost =

Precondition:
Postcondition:

>~ascii text-< or 
ascii text-<

r  him If —

>  « c h u n k  n a m e » = S  
>code<I

I >  %def chunk name<
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An example of a Design Specification file is shown in Figure 2.16, and portions of the output generated by 

TeXspec and BTfeX are shown in Figure 2.17.

MDtfola:
\toca iaa:
D rojuct:

0<t
CC4

Authoc:
D ata:

l . t .  9 U M C  fUfe 21, 2001 
l.B. O U w  
M r  1 3 , 2001  

I n :  Determine n — ini~fâ ief¥lent vault
V0KSMV77 , fUBBCOKM 

Itandard: aose

« d a a « p t u a » *
Datacmaa Tiaa inrtfTiilanT w o lt p > r i t n »  th a t  

l a  OK

Baaed o a  ooda VBMZOr OCC (2001-M Jt*00) t .  MOTCX 
I I d a f  d e a e r lp t lo a

Shared:
now;
Shared:
f lo w :

uput

■SUM
la p u t

up«t

Shared:
f lo w : ou tp u t

Shared: 
f l o e :  u p a t
fr e o o a d it lo a :  1 S \ l e q f  MBIMfT S U e q f  WXXIM

Local: 

Local:

axvcos
KVSOt

VLOdP i ^ l o a a e t a  D ata Plow D iagrm . p ro  
'I a e e r fa o e  w ith  surrota d la y  G aotphara*.

A d d it io n a lly , V U SIP  d e r iv e s  p a r a e e te r s  f o r  v a u l t  
ra g io a a , baaed o a  ehe prope r t i e s  o f  th e  o o ^ o a u i t  
v a u l t  a e c to r s .  t h e  a o o m l a t i o a  o f  m l d p l e  
v a u l t  M o to r s  l a t o  a  a ia g la  v a u l t  r e g io n  i s  
a  S » : g >  a r t i f a c t  in te n d ed  t o  u p c v e  ocapiuta t io n a l  
e f f i o lM c y .

th e  e o u s i s t s  o f  t n  s e c t io n s
Vtoegia (1  t a d i s  )
\ ita m  I v a lu a te  D arcy v e l o c i t i e s  sad. d is p e r s io n  c o e f f i c i e n t s  

r  I n te r fa c e  w ith  th e  lttrro u n d la g  geo sphere*  
i s  th e  th e o r y  M anual).

U t m  t v a lu a te  reg io n  a l l i e d  v a u l t  p r o p e r t ie s .
\e e d C lt e a u e )
<^ua»*

« g a o s p h e r e »
« r e g i o n a l »

I I d e f  main 

\sm

i ts  o f  Darcy M l o d t y  i n  rock  f o r  one s e c t o r
5 tsao.
\
• th e  roam u s  i s  s s su e e d  to  be p a r a l l e l  to  th e  X caaponent 
i o f  th e  g eo sp h ere  n e ta o rk  o a r tM ia n  o o o rd in a te  s y s t s u  
! s c  th e  a n a l  c o v e n a n t  i s  a i M l y  
I IX la d u d  a iq u a t l  on ( DarA_rook ) f  .

j  t h e  tra n sv e r se  g ro u a d ea ter  v e l o c i t y  l a  th e rock  
j i s  M t w y i M " 7 *y u a u e d  t o  b e  i n  th e  t l  p lan e  
j o f  th e  g eo sp h ere  a e te o r k  o a r tM ia n  c o o r d in a te  i / s t n  
j and i s  ev a lu a ted , a s
|  IX in o lu d aeq u atiooC D arf,rock )$ .

i  D e fin e  ( \ t h e t a  \aq m vt  a n g le  b e te e e n  t h e  a a s  o f  th e  roae  
] and th e  d i r e c t io n  o f  v o t e r  f l o e ,  c ^ p u t e  
|  ! \ s i a V l e £ t t \ t h e t a \ u g h t ) |  and 9 \ o o s \ l s f t ( \ t h e t a \ n g & t ) 9 .

i* ksstasa p e z e e a b i l i t y  o f  b u f f e r  i s  n t o »  and 
b aaoa, D arcy v e l o c i t y  m  b u f fo r  i s  aero  
9 \a a th ( D in v ) « 0 $ .  

t  «darx3yC e^ on en ts>3*

! C . . . . . C M t t e  a n a l  and r a d ia l  oea^ eaeata  o f  D arcy v e lo c i t y  
DMOcvk(nc) - Dhnxx(Bie)
oaxKvt(nc) •  iv t{ 0MHZ(ne) » 2  ♦ o»niiiie)**2)

|  C . . . . . l v a l u e t o  s i n  and m s  o f  a n g le  b e t se e n  r o s e  u s  and  
i f l o e
1 ncvixv •  oMumt(nc) r  oanxcsae)
I ocvco* •  oAUcvh(nc) /  mjobuoo
I I t d e f  i l in i  iT i^n aim ir ■

Figure 2.16c Example Design Specification flle.Not all flows o r  ‘code chunks’ are  shown.

Figure 2.16 is not a  complete listing, but illustrates the format of all sections of the Design Specification 

file. The complete listing is contained in Appendix B. Note the ‘description' code chunk just after the 

initial fields. This chunk receives special treatment: it is reformatted into comments and placed near the 

top of the generated code, but is not reformatted in the specification (observe the ‘description’ code chunk 

in Figure 2.17).
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The example module in Figure 2.16 has no arguments. Argument flows are placed in the flow list in the 

order that they occur in the argument list. By convention these flows would be declared before any shared 

or local variables to make this order clear.

Arguments and shared variables may optionally specify a precondition and/or a  postcondition, depending 

on the direction of flow. If the variable has a ‘Condition’ in the Design Data Dictionary, then that condition 

is taken to be a precondition and/or postcondition, as appropriate. Explicitly stated preconditions and 

postconditions in the Design Specification file are added to anything contained in the Design Data Dictionary. 

For example, the variable BKFRAR is declared in Figure 2.16 without a precondition, but the precondition 

0 <  B K FRAR  <  I is extracted from the Design Data Dictionary and appears below the table of shared 

variables.

Preconditions and postconditions for arguments and shared variables can optionally be accumulated together 

in the specification, but after some experimentation, the default behaviour has been set to place the conditions 

separately, below the appropriate table. This generates a longer specification, but keeps associated elements 

at close proximity, which makes the specification easier to read. In some cases (perhaps code which involves 

few variables), the accumulated format may be preferred, so the option to override the default behaviour 

remains.

Tables are formatted dynamically, so that no blank columns are produced. If no mathematical symbols exist 

for any variable in a table, then that table will not contain the ‘Symbol’ column.

The first major heading in the Design Specification is ‘Module Components’, which identifies the Noweb code 

chunks that comprise the default code chunk «  * » .  This section is generated by TeXspec to include any 

chunks specified in the Design Specification file (which are not referenced by other code chunks), plus chunks 

generated by TeXspec. The generated chunks correspond to the sections of the document, but the order in 

the Design Specification is different from the order in «  * » ,  which specifies a compilable sequence.

For example, the «  include »  code chunk is generated and placed before any executable code chunks 

in «  * » ,  but is detailed near the end of the Design Specification. This is because few readers wish 

to use this section, yet it can become quite large. Any declared variables whose Design Data Dictionary 

entry specifies a ‘File’ causes the file to be included in the «  include »  code chunk (‘INCLUDE’ files 

in Fortran). This relieves the user from the burden of assembling the correct header files, as the job is 

performed automatically.
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Figure 3.17; Example Design Specification.

Since th e  product is qu ite  lengthy, only portions a re  shown here.
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Only one table of variables is shown in Figure 2.17). There are no arguments to the example module and the 

table of local variables is not shown to conserve space in the figure. The table of local variables is similar, 

but does not have a column for the direction of Bow (‘I/O’). It would, however, have a column of values if 

any local variables were assigned a constant ‘Value’ in the Design Data Dictionary.

Two executable code chunks, ‘«  main » ’ and ‘«  darcyComponents » ’ are shown in Figures 2.16 

and 2.17. There are several other chunks, but they are not shown. The ‘Module Components’ section of the 

specification specifies the content of the default code chunk ‘«  * » ’. Mote that this references a number 

of generated code chunks and the input code chunk ‘«  main » ' ,  but not ‘«  darcyComponents » ’. 

TeXspec places ail input code chunks that do not appear in other code chunks into ‘«  * » ’ in the order 

that they occur in the Design Specification file. Code chunks that are referenced by other code chunks, such 

as ‘«  darcyComponents » ’, which is referenced by • «  main » ’, are not placed in ‘«  * » ’.

The description of the ‘«  darcyComponents » ’ code chunk illustrates the use of mathematical notation 

to clarify the specification. Some of this notation is input locally, and some is extracted from shared equations 

in ,teq  files via the \inchideEquation{} macro, which causes TeXspec to scan the search list for name.teq 

and insert the contents at the specified position.

2.3.4 Structure Charts

Structure Charts form the high level system design abstraction. They are similar to the format specified by 

Page-Jones [19], but include some additional information and use colour coding, rather than symbols and 

arrows, to specify the direction of data flow.

Structure Charts assemble Design Specifications in a manner roughly analogous to Data Flow Diagrams 

assembling Mini-specs. One difference is that Structure Charts are not layered, so each Module is ‘atomic’ 

and is not decomposed. The result is that a Structure Chart can be very large, so support is provided for off- 

page connectors which allow the user to break a  Structure Chart into sections that can be sized convienently 

for publication. If multiple Structure Chart sections are connected with off-page connectors, then TeXspec 

verifies consistency between them using a method similar to that used for Data Flow Diagrams. For each 

off-page connector, TeXspec searches for a  previously processed Structure Chart with the same name. If 

such a  Structure Chart is found, then the connection is validated, otherwise a  warning message is generated.

Options supported by TfejXspec specifically for Fortran-77 display the status of ‘COMMON’ variables within 

each module, as well as in the argument list.
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The syntax for the Structure Chart file is as follows:

Syntax of Structure Chart (.sc) file

Chart: > chart name in ascii formats
LongName: > descriptive name in ascii format for Structure Charts 
Version: >version number for trucking history - appears on listingsS 
Project: > project identification<
Subproject: >sub-project identifieation<
Author >author's full names
Date: >date that the entry was written<
Implementen >full name of person who input this entry into the system< 
Implement Date: >date that the entry was entered into TeXspec<
Reviewer >-full name of reviewer-^
ReviewDate: >-date of revieuH.
Units: > valid DTtfC units o f measures 
Labels: > ‘long'maximum width and/or ‘shared'<
EntryPoint: >-x,y coordinates in specified units-<
SubmodelColour ^  submodel nametcolowr code (default for submodel)<
>; [submodelcolour] <

>[module|<

> [offpage] <

Where:

m odule =

Module:
At:
Background:
Caption:
CallString:
[call]

> Design Specifications
>x,y coordinates in specified units<
>-colour code<
>-override of module long name-< 
>-x,y:maximum lengths

call =

Call:
Via: 

offpage =

> module or off-page connector that appears on this charts 
>ZX,y point on connecting line<

OffPage:
At:

>nome of child Structure Charts 
>x,y coordinates in specified unitsS

An example of a Structure Chart file is shown in Figure 2.18v and portions of the output generated by 

TfeXspec and WfeX is shown in Figure 2.19.

Much of the information on a Structure Chart is extracted from the referenced Design Specifications. The 

call interface, including the argument list and direction of data flow is extracted from each referenced Design 

Specification and placed above the module, if Labels:shared is specified, then any Fortran COMMON blocks 

are shown, in alphabetical order, with referenced variables colour coded by direction of data flow.

TeXspec performs some consistency checking between the source code contained in the Design Specifications 

and the Structure Chart. If the referenced (called) modules do not agree, TeXspec issues a  warning message
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that extra or extraneous calls are shown on the chart.

If Labels: long is specified, then the ‘Long Name' in each Design Specification is placed with the module, 

as shown in Figures 2.18 and 2.19. If these names are too long, the boxes become excessively wide and the 

user can then specify Labels: longden to specify a maximum width before a line break is used. Likewise, the 

CallString: x,y:len syntax allows an interface string to be broken over multiple lines.

Chart:
LongName:
Version:
Project:
Submodel:
Author:
Date:
Inplemanter:

SIMALL
Inventory of All Nuclides
01A
CC4
INROC
S. Oliver
December 17, 2000
S. Oliver

InplementDate: December 17, 2000
Units:
Labels:

inches 
long, shared

EntryPoint: 2.1,9
Module: SIMALL
At: 2.1,7
Call: NUCINF
Via: 2.1,6.25
Via: 0,6.25
Call: SOURCE
Via: 2.1,6.25
Via: 1.75,6.25
Call: ZAPINT
Via: 2.1,6.25
Via: 2.75,6.25
Call: PRECIF
Via: 2.1,6.25
Via: 4,6.25

Module:
At:
CallString:
Module:
At:
Call:
Background:
Module:
At:
Background:
Module:
At:
CallString:
Module:
At:
Call:
Background:
OffPage:
At:

NUCINF
0,4.75
0.5,6:22
SOURCE
1.75,3
REPFUN
yellow
ZAPINT
2.75.3.5 
yellow
PRECIF
4.5.25 
4.5,6.05:22
REPFUN
1.75.2.25 
INVTRY 
yellow
INVTRY
1.75.1.5

Figure 2.18: Example S tructu re  C h a rt Ble.
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irn.ii MW_______  ____________________
CC-t vault

SIMALL Version 01A
Author; S. Oliver December 17,2000
Implementor: S. Oliver December 17,2^00
Reviewer: none NA

SIMALL
Inventories for all nuclides before simulation, of release 

ncxscijrcciD 
ncuDirssroc 
n a o t n x  
IQCUDIRPBl?

n ucwn̂ vccic* >

NUCINF 
Sector-mdepeadent parameter infbnnatioa 
ctfnaicirarx a r m iiu r n s  jntntDinu
cmai^MA u n a i . t i s u  ireirrtDinur
cipsKiioir̂ it MvcotizLmt migcinrcc
CARXKPimx IQCZDSIVtDXR miTCUTCCPU.
c irsw ia i '^  wwsxuoi?
cunvicur»u n c u o is m
ewawiuirsn iwnxcmr.-.
a n n m r v a  roanxiLiiTxi
oecanp&ats wanxisoû i.
oear iooa< p ia n i^ j^ u .
OForriurm ffarrtonra
onauNsaunnr v a r r io r s a

rMacirtnucwnr*)

PRECIF
Determine valued for precursors 

u a u r ix a n
tim»H3TTO
IDCL£DUn»£
PUnriKCArv
nenriavrw
namu^u.

ZAPINT

! SOURCE

REPFUN

IN V TRY

Figure 2.IB: Example S tructu re  C hart. Input and o u tp u t d a ta  flows are  colour coded green and 

red , respectively. INVTRY Is an off-page connector.

2.3.5 Manuals

For the most part, manuals are simply documents. TfeXspec simply defines the syntax of the equation 

(Section 2.2.4) files to be inserted with the \input{} macro.

Further support for manuals will be provided once a configuration management system is incorporated into 

TjjjXspec.

Also. the CSA standard [4] demands a  number of specific documents, and templates will be provided.
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3 Graphical User Interface

To assist in the operation of the TeXspec system, a GUI is provided, making the application much more 

intuitive to operate.

For the purpose of this practicum, the intention was to implement a "simple but effective’ GUI. Unfortunately, 

these objectives are not always consistent and the program now comprises over 32,000 lines of source code 

in 85 modules. This compares to 8,000 lines of PERL code in 8 scripts to implement the core TeXspec 

technology. At this writing, the GUI is in regular use, and has proven to be fairly robust.

3.1 Architecture

The GUI fits into the TfeXspec architecture as shown in Figure 2.1. It is implemented as a Java application. 

It manipulates the input files, executes the PERL scripts, and handles the output.

The application is distributed as a Java archive (.JAR) file and is initiated by a Java runtime environment. 

From a command line, this often looks like:

java - j a r  TeXspecGUI

The initial presentation is as shown in Figure 3.1. The 

user must identify himself and declare a  default project 

on which he will be working.

The options presented on the ‘login’ screen indicate the 

future development path of the product. At the mo­

ment, the options (user identification, project, and sub- 

project) are "hard coded’ into the application and the 

"Password’ field does not process input. These fields 

will have meaning when the application is divided into

client and server portions (Section 2.1.1) Figure 3.1: TeXspec G U I In itia l Screen.

The GUI is based on components provided with Java and two additional libraries; 

e ‘regexp’: regular expression parser from The Free Software Foundation (FSF) 

e ‘format’: Henrik Bengtsson’s printf package (for non-commercial use).
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TeXspec components tend to be small and held in many files. Repeatedly opening a large number of files 

tends to inhibit performance on many systems, so the GUI has an abstract class ‘TeXspecComponent’

which establishes and maintains an inventory (cache) 

of components that have already been parsed. A back­

ground process periodically scans the search list direc­

tories (Section 2.1.2) for files that have been updated 

since they were last parsed and placed in inventory.

The number of windows generated by the GUI can be 

large. A desktop window is used to contain these win­

dows, which avoids cluttering the user’s main desktop 

with many TeXspec windows and icons. The desktop

Figure 3.2: TfeXapec G U I D esktop Screen. T he b a r window also provides a convenient place for a progress
along the  bo ttom  is a  ‘progress bar* and  message area. , , . P . „ „bar, as shown m r  igure j .2.

3.2 Configuration and the Search Lot

Since the GUI is used to create and edit TeXspec components, as well as process them, the search-list has 

an additional role to play beyond the base functionality. The first directory (for each file type) defines 

the directory in which output will be written. Mo output is written to directories lower in the search-list. 

although they can be deleted. If a component is accessed from a lower directory, then edited and saved, the 

edited copy will be written to the first directory in the search-list. By placing a working directory at the top 

of the list for each file type, the user can collect his working files as they are modified and move them to the 

appropriate directories once the products are known to be satisfactory.

The Search List (Section 2.1.2) can contain a large list 

of directories to be searched. This would be oner­

ous to regenerate each time the GUI is invoked. To 

avoid this, the GUI allows the user to load a 'Configu­

ration’ (which may in the future contain more than 

the search list). This allows the user to work on 

multiple projects without having to manipulate the 

search list on every invocation. To load a configura­

tion, use Optiona->Load Configuration to bring up 

the chooser window, as shown in Figure 3.3. Ftgure 3'3: Cboonr to " lect a flIe containinK a
noarcft-lutc.
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Initially, however, a search list must be built before it 

can be saved and subsequently reloaded. To manipu­

late the list of directories, use Options->Search L ist 

to bring up the search list editing window, as shown 

in Figure 3.4. A drop-down menu allows the user to 

select a file type and directories can be added (via a 

pop-up chooser) or deleted using the edit buttons. The 

•Up’ and ’Down’ buttons allow the order in which the 

directories are searched to be manipulated. When the 

list is complete, use Options->Save Configuration A s.. to save the search list.

3.3 Requirements Data Dictionary

Requirements Data Dictionary entries define flows or components of flows which occur on DFDs (Sec­

tion 2.2.1).

They can be accessed by the following methods, from the F ile  menu:

• File->Hev->Requirements->Data Dictionary Entry 

to create a new Data Dictionary entry.

• File->Open->Requirements->Data Dictionary Entry

to edit an existing Data Dictionary entry (or create similar ones).

• File->List->Requirements->Data Dictionary Entry

to see a  list of existing Data Dictionary entries, or generate a  formatted listing, suitable for printing 

(Section 3.5).

The F ile -> L ist method allows the dictionary to be accessed horn an alphabetical listing. After scanning 

the search list for the appropriate files, a window, as shown in Figure 3.5, displays the candidate entries. 

By default, these are in alphabetical order, but an option allows the entries to be sorted by project. The 

•Refresh’ button causes the search-list to be scanned for changed entries.

Multiple entries can be selected for ‘Edit’ or ‘Delete’ by holding down the “shift’ or 'control’ buttons while 

selecting with the mouse. Editing is initiated with either the ‘Edit’ button or a mouse double-click.

The ’Generate Listing’ button activates the Dictionary Listing window, as shown in Section 3.5.

Keeping a dictionary listing on hand is a useful method of avoiding logically duplicate entries. Scanning the

39
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‘Long Name’ column can quickly identify any existing definitions that might be used instead of a new entry.

Since the listing is generated from files 

and the time stamp on each file is 

checked before the listing is displayed, 

the dictionary listing can be slow to 

generate, particularly if a long search 

list is employed. It is usually a good 

practice to request a dictionary list­

ing when the GUI is started and to 

keep the window for reference (per­

haps shrunk to an icon).

Having arrived at the ‘Edit’ window, 

via one of the mechanisms outlined 

above, as shown in Figure 3.6, fields

are analogous to the Requirements Data Dictionary (.rdd) file (Section 2.2.1). Note the support for compos­

ite entries: the ’Add’ button brings up the full list of available Requirements Data Dictionary entries, from

which the desired components can be selected. 

The ’New’ button brings up an empty Re­

quirements Data Dictionary entry, which can 

be filled in and, when saved, becomes incor­

porated into the current entry. Similarly, the 

‘Edit’ button can be used to edit a child entry 

(if there is one).

Changing the ‘Name’ and saving creates a new 

Requirements Data Dictionary entry. This is 

a  quick method to create several similar Re­

quirements Data Dictionary entries.

The 'Math Name’ field is intended to have 

a preview button, to allow for the fact that 

DTtjpC equations often require more than one 

attempt to achieve a correctly formatted re­

sult. This has not yet been implemented.

M U n l fit iMffielMt -|M- te  ilfka nflilplt. 
I«m4 Ir Um ealoaUU* rf rf Uw fcytriitlm cat* f«r 
wit iwfmi a u  «£ tamL

Figure 3.6: E d it & R equirem ents D ata  D ictionary e n try

Figure 3.5; List o f  Requirem ents D ata  D ictionary entries.
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3.4 Design Data Dictionary

Largely analogous to the Requirements Data Dictio­

nary, the Design Data Dictionary entries are referenced 

in much the same manner, but the editing window is 

slightly larger to handle the increased number of fields 

(defined in Section 2.2.2). Recall that the Design Data 

Dictionary entry may be mapped to a Requirements 

Data Dictionary entry, which can eliminate the need 

for some of these fields. Inheriting a 'Math Marne’ or 

'Description’ can save both typing and maintenance 

effort.

The ‘Select’ button brings up the full list of available 

Requirements Data Dictionary entries, horn which the 

corresponding entry can be selected. Alternatively, the 

name can simply be typed in.

3.S Dictionary Listing

From the F ile->L ist window for either type of Data Dictionary entries, the 'Generate Listing’ button 

will bring up the window shown in Figure 3.8. This window provides an interface with ‘formatDD.pP out­

lined in Section 2.2.3, through the script file 'for- 

matDD.bat’. The mechanism is outlined in Sec­

tion 3.11.

The dictionary listing module is very flexible (see 

Figure 2.7), and capturing all of that flexibility 

might result in an unnecessarily complicated in­

terface. Some of the flexibility is compromised to 

achieve a more intuitive interaction. The available 

columns are easily seen and the column width can 

be adjusted, but the order of the columns cannot 

be controlled. Should experience prove that the 

order of the columns is important, then the design 

Vi™™ 3.8: Go no rata a  Data Dictionary Liatina. of «*» "Jay be reviewed.
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3.6 Process Specifications (Mini-specs)

Process Specifications are required for all atomic processes which occur on DFDs (Section 2.3.2).

They can be accessed by the following methods, from the F ile  menu:

•  File->fiew->Requirements->Process Spec 

to create a new Requirements Specification.

e File->Open->Requirements->Procesa Spec

to edit an existing Requirements Specification (or create similar ones).

e File->List->Requirements->Proce88 Specs

to see a list of existing Requirements Specifications, or generate formatted listings, suitable for printing.

Flows on a Process Specification are Requirements Data Dictionary entries and are shown in tabular form 

on the editing screen, as illustrated in the leftmost window in Figure 3.9. Selecting a ‘Flow’ and pushing the 

‘Edit’ button causes a Requirements Data Dictionary edit window (Section 3.3) to come up.

In Figure 3.9, the ’Add’ button was used to bring up the list of Requirements Data Dictionary entries at 

the upper right. Selecting an entry horn this window to form a  new Sow caused the window on the lower 

right to prompt for the direction of the flow (the remainder of the window echoes the content of the selected 

Requirements Data Dictionary entry in non-editable form).

Flows can be resorted according to several sorting schemes by toggling the ’Sort’ button.

Mote the support for a bibliography using BibTfejX. Filling in the bibliography fields will cause the appropriate 

Bib'IfeXcommands to be generated.
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Figure 3.9: E d it a  Process Specification.

3.7 Data Flow Diagrams

Data Flow Diagrams are high level abstractions of requirements, specifying conceptual processes and the 

flow of data between them. TfeXspec DFDs use a  modified Yourdon/DeMarco format traditionally employed 

by the DGRTP.

They can be accessed by the following methods, from the F ile menu:

• File->{feu->Requirements->Data Flow Diagram 

to create a new Data Flow Diagram.

* File->Opea->Requirements->Data Flow Diagram

to edit an existing Data Flow Diagram (or create similar ones).

# File->List->Requirements->Data Flo? Diagrams

to a list of gristing- Data Flow Diagrams, or generate formatted listings suitable for printing.
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The fields on the Data Flow Diagram editing screen are analogous to those in the Data Flow Diagram file 

(Section 2.3.1).

"Elements’ on a Data Flow Diagram may be:

• atomic processes with a corresponding Process Specification,

• a child Data Flow Diagram,

• a data store, or

• an off-page connector.

The first two options are represented as circles (often called bubbles), and are grouped together as 'Processes’. 

They are distinguished in the "Type’ column of the "Elements’ section of the edit window. Selecting a 

process and pressing the "Mini-spec’ button will make the process "atomic’, create a Process Specification 

(Sections 2.3.2 and 3.6) and bring up an edit window as shown in Figure 3.9.

‘Flows’ on a Data Flow Diagram are shown in tabular form in the ‘Flows’ section of the editing screen, 

as illustrated in Figure 3.10. The 'Content' of ‘Flows’ on a Data Flow Diagram are Requirements Data 

Dictionary entries.

The edit screen shows the relationship between ‘Elements’ and ‘Flows’ by changing the typeface of the ‘Flows’ 

associated with the selected ‘Elements’ to a bold font. Likewise, the ‘Elements’ at either end of selected 

’Flows’ are shown in bold type.

Since the number of fields associated with both ‘Elements’ and ‘Flows' are fairly small, they are placed 

on the edit window and no child windows are used. Valid data must appear in the data fields before the 

‘Add/Update’ buttons become active.
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Figure 3.10: E dit & D ata  Flow D iagram .

3.8 Design Specifications

Design Specifications are required for all code modules (Section 2.3.3). 

They can be accessed by the following methods, from the F ile  menu:
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• File->New->Deaign->Module Spec

to create a new Design Specification.

• File->Open->Design->Module Spec

to edit an existing Design Specification (or create similar ones).

• File->List->Deaign->Module Specs

to see a list of existing Design Specifications, or generate formatted listings, suitable for printing.

Symbols in a Design Specification are Design Data Dictionary entries, and are shown in tabular form on the 

editing screen, as illustrated in the leftmost window in Figure 3.11. Selecting a ‘Symbol' and pushing the 

‘Edit’ button causes a Design Data Dictionary edit window (Section 3.4) to come up.

Note that the symbols are presented as two tabbed tables, one for ‘Arguments’ and the other for ‘Vari­

ables’. Data Sows can be considered to be all ‘Arguments’, plus those ‘Variables’ that are in shared storage 

(COMMON blocks in Fortran).

In Figure 3.11, the ’Add’ button was used to bring up the list of Design Data Dictionary entries at the 

upper right. Selecting an entry from this window to form a new flow caused the window on the lower right 

to prompt for the direction of the flow (the remainder of the window echoes the content of the selected 

Design Data Dictionary entry in non-editable form). While the window is labeled 'Flow1, in fact it declares 

a symbol, and specifying no flow direction causes non-shared symbols to become local variables.

The ’Flow’ edit window allows the user to specify preconditions, postconditions and initialising data. Having 

the non-editable Design Data Dictionary fields displayed in the same window helps to avoid conflicts or 

duplication. The ‘Units’ and ‘Dimension’ of the Design Data Dictionary entry are subject to override here.

Note the support for a bibliography using BibTfeX. Filling in the bibliography fields will cause the appropriate 

BibT^jXcommands to be generated.

Noweb code ‘Chunks’ are input in commentary-code pairs in the tabbed panes on the edit (leftmost) window. 

Pressing the ‘Add’ button causes a a dialog to prompt for a name and a  new pair is generated. Because 

‘designspec.pl’ places Chunks into the default Chunk in the order that they occur, the Chunks are numbered 

and the ’Up’/ ‘Down’ buttons causes the selected Chunk to change it’s position in the sequence.
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Figure 3.11: E dit a. Design Specification.
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3.9 Structure Charts

Structure Charts are high level abstractions showing the relationships between code modules (Section 2.3.4).

They can be accessed by the following methods, from the F ile  menu:

• File->Neu->Design->Structure Chart 

to create a new Structure Chart.

• File->Qpen->Design->Structure Chart

to edit an existing Structure Chart (or create similar ones).

• File->List->Design->Structure Charts

to see a list of existing Structure Charts, or generate formatted listings, suitable for printing.

Having arrived at the ‘Edit’ window, shown in 

Figure 3.12 (top), fields are analogous to the 

Structure Chart (.sc) file (Section 2.3.4).

The top of the window identifies the chart and 

sets up some page layout parameters. The next 

section allows default background colours to be 

assigned to modules by sub-project, which is 

useful if the code calls modules from libraries 

that are not considered part of the same project.

The final section of the main editing screen is 

the list of modules that are to appear on the 

chart. There are a sufficient number of fields as­

sociated with each module on the chart that a 

sub-window is used for editing them. The drop­

down list of other modules on the chart (on the 

right of ‘Sub-Program Calls’) allows the selec­

tion of modules which are to be called by the 

current module.

Changing the ‘Name’ and saving creates a new 

Structure Chart. This is a quick method to cre­

ate several similar charts.

th e  bo ttom  edits a  single module on th e  chart*
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3.10 Manuals and Equations

Currently, no support is provided for TfeXspec equations or manuals, but these items are present on the 

menus as an indication of future development.

3.11 Java <-* Peri Interface

The underlying TfeXspec technology is implemented as Perl scripts, but the user interface is a  Java applies 

tion. In order for the user to generate T^Xspec products, the Java application must interface with the Perl 

scripts.

Both Perl and Java are relatively portable, but 

there is no portable interface between them 

defined in the Application Program Interface 

(API) of either. It is necessary, then, to define 

such an interface for TfeXspec.

The interface could be implemented in sev­

eral ways. It would be possible, for example, 

to set up an interprocess c o m m u n ic a t i o n  sys­

tem [25,26] between the GUI and a  server ap­

plication which would be responsible for run­

ning the T ĵXspec Perl scripts. Such a server 

application could be implemented in Pert in 

a portable maimer and would be a stepping 

stone to future TfeXspec development.

Figure 3.13: TfeXspec A rchitecture for running  Peri scripts 
For the sake of simplicity, however, the GUI from the Java G U I. T he user asks for a  listing to  be generated 

uses the Java ‘Runtime.execO’ function to ex- which initiates ‘name.bat* to execute the  l^X apec scrip t, and
> . . . . . .  . .  optionally perform  o ther functions.ecute a command, which is itself the name of

a script. For each Perl script ‘name.pl’, there exists a corresponding initializations script ‘name.bat’ which 

the GUI can *exec()' to run the Perl script, as illustrated in Figure 3.13.

The script name ‘name.bat’, is selected to make the implementation as portable as possible. MS-DOS prefers 

scripts with such a name, and UNIX accepts it. Although a  Macintosh implementation has not been written, 

no difficulty is foreseen.
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The script based interface offers & further advantage. Since ‘name.bat’ is typically a short script, it can be 

customized to perform other functions in addition to running the TeXspec Perl scripts. Since the TeXspec 

outputs are primarily MfeX files, it is convenient to run BTjjjX once the l£Xspec script has nm to successful 

completion. A viewer can then be initiated to show the product on the screen.

This is particularly useful in the case of ‘'designSpec.bat', since in this case TfcjXspec produces a Noweb file as 

output. The script can continue processing to generate both the Design Specification and the corresponding 

code. The documentation can be displayed and the code can be further processed, including compilation. 

The sample ‘rfesfynSpec.bat’, provided with TEXspec, executes the ‘Floppy’ [2] tool to reformat and provide 

a static analysis of the generated Fortran code.

The location of the scripts to be run (both interface and base TeXspec) is defined to the GUI using the same 

‘search list’ arrangement used to locate other files. By modifying the search list, it is possible to override the 

default processing with revised scripts which reflect the current project, user preferences, or the particular 

job at hand.

Output horn the processing of ‘name.bat’ is displayed to the GUI user. The display is in three sections:

• Output, which includes both ‘standard output’ and ‘standard error1 listings.

•  Errors, to reduce the possibility of error messages going unnoticed in voluminous ‘standard output' 

and

• a button to interrupt the process or dismiss the display.

Figure 3.14 illustrates the format of the display.
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BETAD8
C8AUNA
CVTBV
CLCSOL
CNCNCU
CONFLO
ELM80L
FUXND
F8CYL
FULRAO
OAMU38
OETSOL
HOLCON
MYDCON
NFILL
NON
NNFLO
WTM
NVTHY

■••dM l® dpec.b«c: Running X:\aedp_9iC4\Conflg\TEX3IEC\yer000d\bln\dt9lgn3p9C.pI co produce nomb] 
("d es ig n Jp ec .b o c : Running nostave co produce cbe i n l d i l  MTcX specitlcm don  

b»no«eeo t Backup: Mikup AL PHDS.ex
torn  backend: cotex -noindex -  delay 

it la rk ing  up
b»noeceve: naming  beckesd: <cocex -noindex -deley>

| ,a dejlgn3ptc.bec: Burning nocengle co produce i n i d e l  C occus 
» »noceogle: eerkup UBHDS.nx I nc -U *

|* * d esi9 iSpec.beci Running c lem foccran  eo renave blank 11 nee Cron cbe FOKIRAI 
■••designSpec.bec: Burning floppy co re fo rsac  cbe rOKIMI 
[••designSpec.bac: Running floppy co generece e  9 co d e  analysis
I**dssl9 dpec.bac: Running cleonctx co res eve cedundenc secdons oC cbe LeTeX op ec iflc tc io n  
| tTd99ignSpec.bec: Running pdflecex co process the  LeTeX s p e c id c td a n  

19 pdtTeX. T tre ion  3.141S9-14E-telcosed-20aa05Z5 (BIKTeX 2 bece 6)
I (AUHD3. cex(pdtcex .ctj)
|U T e » e  <2000/0d/01>

Bobel <v3.1]> end hyphenedon petcerns fo r cng llsb , french, gerxan, ngernen, du 
mylsng, nobyphenedon, landed.

|  (C:\prog\cex\texUacex\TtXspec\De9ign3pec. e ls
Docunenc a m :  DeoignSpec 1999/10/10 vl.O TeXspec Oeoign-Opec 3 .O liver

t eerkupc mertup UFSDS.os 
rove backend: cocex -noindex -delay 

tc aerking up
:: running beckendr <corex -ooindex -deley>

o tang le: aazkup AtPHDS.n* I nc  - I lk

MHONS 02C
--------- Cdd----------

ICC4 Vault
MJIONS 02C CC4 vault L

COA

Figure 3.14: TfeXspoc script being ru n  from  th e  G U I. T he ‘errors’ are  any  ou tp u t d irec ted  to  th e  ‘standard  

error’ o u tp u t stream . Noweb sends some messages to  this stream .
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4 Conclusions

Prior to the development of TeXspec no CASE tool could be found which could simutaneously

• produce Yourdon/Demarco structured analysts documentation,

•  support scientific and mathematical notations,

• enforce ownership of components,

•  permit sharing of components,

• assemble large products horn smaller components, and

•  verify consistency between products.

TeXspec is a  fully usable tool capable of producing highly presentable and reliable software documentation, 

featuring robust mathematical notation. Reuse of components and automatic checking between products 

reduces the chance of inconsistent documentation, which has been a major source of software defects in the 

past.

TeXspec satisfies the requirements specified in Section 2.1.1.

The TeXspec tool achieves the objective of offering automated support to assist developers of technical 

software who wish to comply with the CSA N286.7 standard [4]. Compliance is expected to become a 

requirement for licence applications to the CNSC.

4.1 Maintenance and Future Development

It should be noted that TfeXspec development has been, to date, a one man show. If the product is to be 

developed in another manner, the following skills are essential to an understanding of the technical aspects 

of the implementation:

• Java, including Swing,

•  PERL,

• HFÎ jX, including the generation of "class' files, and

•  WawaJv
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Fortunately, these skills are common and none is difficult to learn, with the possible exception of KTĵ X 

'class’ files.

The following items are considered priorities for future development:

• Editors could be added to the GUI to handle equations and manuals.

• The parsing of the TfeXspec files by the GUI is performed by an ad-hoc implementation based on the 

FSF regular expression parser ‘regexp’. In fact, there exists a YACC-style parser for Java. JYACC 

could replace the current parsing. This would make the parsing code more compact and easier to 

modify or extend.

• Input file formats may be converted to a format which is easier to parse. For example, TfeXspec may 

be a natural fit for Extensible Markup Language (XML). This would make processing of multiple 

line fields easier to process. Internal Sags used to keep track of what field is being parsed could be 

eliminated.

• The configuration file is named as a 'resource file’, which typically retains settings between runs. The 

configuration file might be one entry in a true resource file and could be loaded at invocation.

• The GUI support for the graphical products (Data Flow Diagrams and Structure Charts) could be 

based on editable graphics, or perhaps provide a ‘preview’ window. Raving to process the file to see 

the format of the output is not optimal.

• More types of diagrams could be supported, including Object Oriented abstractions. Object Oriented 

technology from the ArgoUML [22] project might be reusable for this purpose.

• Data flow diagrams could support ‘control’ flows, as defined by Yourdon/DeMarco [5, 30]. This dif­

ferentiates between flows that control the nature of the processing from flows containing data to be 

processed.

• Languages other than Fortran-77 could be supported.

• Some allowance for tracing between design and requirements could be provided. Currently, the most 

useful link between requirements and design is the mathematical specification of Design Data Dictionary 

entries, which may correspond to Requirements Data Dictionary entries, which allows a reader to 

associate variables in Design Specifications to terms in Process Specifications. It would be advantageous 

to allow a Design Specification to explicitly declare what requirement is being met.

• The TeXspec system could be divided into client and server portions, with traffic between them over 

a network.

• The system could allow installation of files into a configuration management system. Dependencies 

between tiles should be monitored from this system, and security wouid be enforced.
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A Sample Data Flow Diagram

Figure A.2 details the input required to produce the Data Flow Diagram shown in Figure A.l. The syntax 

is discussed in Section 2.3.1. For convienence, the input has been divided into sections, delimited by a line

of hashes. Mote that this file would typically be generated and maintained through the GUI.

The first section contains the identification 

information common to all TeXspec compo­

nents.

The second section indicates that the posi­

tions on the diagram are specified in inches, 

and that the ‘Marne’ field in the Require­

ments Data Dictionary entries are to be used 

to label the flows. Alternatively, the ‘long’ 

name or mathematical symbol could be used.

The third section specifies the process ‘bub­

bles’ to appear on the chart. Mote that pro­

cesses 1 and 3 are specified to be ‘atomic’, in­

dicating that they are associated with a Pro­

cess Specification (Mini-spec), while process 

2 is associated with a child diagram.

The fourth section specifies the location of 

o3-page connectors. This particular diagram 

on the right, but this is not a requirement.

The largest section details the ‘Flows’ to appear on the diagram. Each ‘Flow1 in the diagram is defined with 

a Requirements Data Dictionary entry similar to Figure 2.5.

The final section contains notes to be placed on the diagram. This is often supplemented by notes generated 

by TfejXspec to indicated the treatment of composite Requirements Data Dictionary entries.

tsr
I .I UKW

CCL
nf*

CSUL

CSUL

Implemented by SPCGCN
eqofllbriuiiKoniUBU «  {m4aorjq,KCASUL.KW} 
ip-ton m  {^»mk»,n*njcB, ferial} 
gwifdMion m  {enacjalnai, 1ST} 
anc-majorwicnas {CCL, CSUL}

«1

Figure A .l: Sample D ata  Flow Diagram .

employs a convention placing inputs on the left and outputs
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B Sample Design Specification

Figure B.3 details the input required to produce the Design Specification shown in Figure B.l. The syntax 

is discussed in Section 2.3.3. For convienence, the input has been divided into sections, delimited by a line 

o f '%' characters.

B .l Output

The header contains the identification information common to all TeXspec components. To keep track of 

the components used to assemble a Design Specification, or any TfejXspec product, the KTfeX files generated 

by TeXspec contain commentary that identifies all referenced components, and the version of the TeXspec 

module that assembled them. A date-time stamp is visible above the header in Figure B.l (in the upper 

left corner) to uniquely associate the KT̂ jX file with the associated product. By retaining the I#T£X file, it 

is possible to audit the content of any product. Figure B.2 shows the top of the I£I£X file associated with 

Figure B.l. Mote the matching date stamps and the list of components, including version identification.

Below the header is the default code chunk «  « » .  The code chunks that are represented by tables 

( «  argument » ,  «  local » ,  etc.) are generated and are not identified in «  « »  by obvious 

association. The TeXspec module cleantex.pl removes these code chunks from the Design Specification, 

since the tables contain a superset of the information in the associated code. Generated code chunks that 

are not represented by tables ( «  interface » ,  «  description » ,  etc.) are displayed using the usual 

Noweb notation.

User written code chunks, which are not referenced in other code chunks, are placed in «  * »  in the order 

that they occur in the input. In this case «  checkArrayBounds » .  «  initialize » ,  and «  main »  

are in this category.
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CC4 INROC
i Module ALPHDS : Sirmdate fuel release from alpha radiolysis Vernon 02H

Author S.E Oliver Feb 23.2001
Implementer S E  Oliver Mar 16. 2001
Reviewer T.W. Melnyk Mar 16. 2001

Module components:
n =

(mcerftce)
(description)
(directives)
(include)
(argument)
(local)
(data)
(checkArrtyBounds)
(initialize)
(mem)

Description:
{descn'prion}=

Simulate fuel re le a se  fro a  Alpha r a d io l j s i s .

Calling interface:
{interfxs)=

SUBSCUTIKE U?HD3(CAI.7TP.I(T.” ,B3,AU1KH£.aarra.CKZ

Arguments:
Argument LangNtme Symbol Units Dimension 0aea7ype I/O
CALTYP a l l  type- "TIMES* or "VALUES" n • character

NT number of times in subsenes (i scalar integer I/O
TIMSS times for user bme series h i • double I/O

ALPHRE release rate from alpha radiotysrs A ci.lt | (mol/a| • double 0
CONTIN continuation flag n scalar boolean 0

OK operations thus far ok Hag Q scalar boolean 0
Preconditions:

NT: non  if CALTYP = "TIMES*
> I  if CALTYP =  "VALUES'

TIMSS: now if CALTYP — "TIMES'
> 0 for (1..NT) if CALTYP =  'VALUES'

Postconditions:

NT: < S t- NQALPH if CALTYP = "TIMES' 
unchanged if CALTYP =  "VALUES'

TIMSS: > 0 for (I..NT) if CALTYP =  "TIMES* 
unchanged if CALTYP -  "VALUES' 

ALPHRE: unset if CALTYP = "TIMES'
>Ofar (L NT) if CALTYP ^VALUES' 

CONTIN: =  TRUE.
OK: = .TRUE

Figure B .l: Example Design Specification ( i  o f 5).
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Constants (PARAMETER):
Constant Loot Him* Units DataType Vilu*
MXUDOS Max dou ran  a  wits far radiolysis :i integer 20
TDELTA duration of delta fn input double o n :

Shared (COMMON) variables:
Stand Lang Nina Symbol Unas Dimension DaaType I/O

AALPHA Fit coefficient a far alpha radiofysa On scalar double 1
ALFCOF Sale factor for alpha dose ss. salar double 1

ALPHDO alpha dose to used fuel surface a |Gy/a| MXUDOS double 1
ALPHTl am* values for alpha dose rate >1 MXUDOS double I

BALPHA Fit coefficient b for alpha radiolysis 6. il salar double 1
CALPHA Esc variance alpha •ht I salar double 1
□ALPHA Number of data paints for alpha dose fit B salar double 1
EALPHA Statistial parameter alpha radiolysis V(U«o* b«o)* 5 salar double 1

FALPHA Mean experimental alpha radkdyss Ega (1 salar double 1
NOALPH num entries in alpha doe* ts ru. U salar double 1
STDNOA std normal vanat* for alpha dose rat* X.(0. -I n salar double 1

TCOOL effective cooling time >i salar double 1
USURFA effective surface area .t Im2| salar double 1

Preconditions:

AALPHA: « t
ALFCOF: > 0 for if CALTYP = "TIMES* 

non* if CALTYP - '  VALUES*
ALPHDO: > 0 far (I, NOALPH) if CALTYP =  "TIMES* 

non* if CALTYP =  "VALUES'
ALPHT1: > 0 fbr(L.NOALPH) if CALTYP =  "TIMES' 

non* if CALTYP =  'VALUES'
BALPHAtset 
CALPHAtset 
OALPHA: sat 
EALPHA: sit 
FALPHA: set
NOALPH: I <  NOALPH < MXUDOS
STONOArwt
TCOOL: > 0
USURFA: > 0

Local variables:
Local Lang Name Symbol Units Dimension OataTypt Non

ALFDRL dimensianless and factored alpha dose 0 MXUDOS double save
ALFREL relative alpha dose rat* [Gy/a| solar double
ALFTRL dimlm am* far alpha dose rat* Q MXUDOS double save
DOAFLG DOALOG is alculated 0 scalar boolean
DOALOG lag(pr*dict*d alpha dose rate) log(d) B scalar double
EXPONA logf predict id alpha corrosion rau) logs,(t) D scalar double

1 general index 0 scalar untftr
J general index a scalar tnagtr

MODNAM module name 0 6 character
MSG error message D 64 character

REFRAA relative alpha dissolution rat* [mol/(m£a)| scalar double
STOPP signal to stop processing Q scalar boolean

T1MREL relative am* [a| scalar double

Oata:

MOONAM: ’ALPHDS" 

STOPP: TRUE.
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Module Pracosetithms

ALPffllCD < L'DEtTA +- TCOOL

TMi mothda k  ueed by SYVAO to a t  up a time series. Far aach dm* series. It to lin t called anai with 
CALTYP =  "TIMES"; than H it csled possibly many tfcnoa with CALTYP =  "VALUES" until tha timaseries 
to coawplata.

Eacaptlons

IT a ttahia cannot ba intsrpoiatad a t any particular thna bacaana af bad doae-time data an error message to 
written uling WERR

IT CALTYP 4- ("TIMES" or "VALUES") NT.TIMSS .ALPHRE and CONTIN are not Mt and an error maaaga 
to written uling WRERR

Summary
ALPHDS hnpiamenti OaU Flow Diagram procasMt 'Fual Dissolution Rata Alpha’, and acatoi to tha aairfaca 
araa of tha fuai (la part of Calculate Total Fuel Plato elation Rata’).

Tha doae-time raiatianahip to provided numaricaly aa n« onlerad tima-dOM pain. The final valae provided to 
continued at a conetant  far i l  longer timet. Unear intarpoiatlon on the logarithmically transformed values 
to uaad h r  all intwmarllarn times. To avoid numarical problems with logailthma of snail times, the date to 
assumed to ba taro h r  times smaflar than tha snail tima TDELTA.

Tha primary function to to impismani  tha theory manual equations in the 'Degradation Rata of Fuel* section, 
h r  n-radWytia. scaled to the fuel surface araa. That to. wa an  computing A c ,(i|. Ham. the theory manual 
notation would have d ~ a  in 4r(l) ■'Cr(l) IQ-v-‘1" l|*v—■*.

Thto implementation generates a SYVAC3 time series, and is designed in accordance with tha template provided 
with SYVAC3. The input and output arguments are defined by tha template.

Check the numerical doae-time function that the user njppfied in the input file (aa sampled parameters ). If too 
many data pain have been supplied than writa an error inewage.
{d>tckAmyBoonds)=

C.....Check array bounds
IF (nXTOOALPH) .CT. KXKBB) TEEN

ESC •  'FUEL DOSE VALUES OUTSIDE AHAAT HOUNDS '
CALL VRE3E(EQDHAN.!SG,STUFF)

END IF

Initialize local variabiat and tha output argument  "OK".

ALFREL. TIMREL and REFRAA a a  always unity, and am uaad to restive physical units of tha values. This 
aaatots tha UWTCK (urit checker) static analysis toaL
( rru tu fta )=

C . I n i t i a l i z e
OK • .TRUE.
ALFEEL ’  I.DO 
REFHAA -  I.DO 
TINHEL -  I.DO

r ig u r e  a . I :  n x e m p ie  D esign  apocinca iion  (3  o t o j .
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Dotarmina tha modula How bated an tha 'c jl  type'. S%nal an error if tha cat type it neither “TIMES" nor 
"VALUES".
(rrurn)=

r ?  (CALTYP .£3. ‘TIKES') THEE 
{initulTmts}

ELSE IE (CALTYP ,E8. ‘VALCES’ ) THEN 
(juppfy/a/ue)

ELSE
MSG ■ ‘UVIDENT1EIA3LE CALL TYPE ' / /  CALTYP 11 

t  SHOULD BE “TIMES" OR "VALUES"'
CALL WHEHR(*QD*AK,KSC,STOPP)

EDO IF

RETURJ
END

Provide uma timai to bdtializa tha ttma aariaa. Tha input Ha containa (tfme.alpha-doee) pain in pan met an 
(ALPHTI,ALPHDO). ThaM timai are ofTiat by Urn cooing time TCOOL. For MtiaEtation tima* ma al tha 
time* on the doaa tima function euppNed and a number of time* around TOELTA where a diacontinuity occun.
Aieo, (nitialbe tha doaa value* in tha doae-time function, by rcaing by tha uncertainty factor ALFCOF. A 
lingi* uncartabity it appiied to tha data fir each aimuiation uaing the rampied parameter STONOA. than uaad 
coneietently (legardla** of thna or doee rata) throughout the dmulation.
•••MOTE*”  Thit code could be chanced to redefine AIFORL to contain tha h>f (doee). TWa would ramtwa 
tome of the oearhaad (or interpolation between point*. Alao. the Intarpoiation itaaif could ba performed by 
SYVAO if tha doaa thna function wan reprteamed a* a thna aerie*.
(rmtufTimes)s 

irr - s
TIKSS(l) •  TDELTAet.OlDO 
TIMSS(2) -  IDELTAat.OOOOOIDO 
TIRSSO) * TD£LTA*0.99D0 
TIMSS U ) -  IDCLTAaO.99999900 
n iS S (S )  * TDELTA •0.5D0 
TIMSS(fi) ■ TDO.TAaO.IDO 
CO J  •  I.EIKTCHQALPH)

Vi (ULFEtlCJ)-TCaDL) .SE. O.DO) TEES 
JT -  ST*1
TKSSCSI) -  ALPBnCD-TCCCL 

END IE
C.............. I n i t i a l i z e  th e  do ee-tm a  (unc tion  by applying
C.............. th e  u n c e rta in ty  fa c to r  ALFCCE and ao n aa lir in g  to
C.............. reeove phyeical un ite

ALfDRL(J) -  ALPKDOCJ) •ALFCCE/ALFHEL 
ALEIBLCJ) -  ALPRTKD/TDtREL 

END DQ
a n r a i  -  .tube.

r i g u r e  n . i :  e x a m p l e  u c a i | n  a p e c m c a t io n  ( e  a t  a ; .
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Compute a »UMfcm r a n  dua to  a  radiaiytit a t  ipadfiad tim at.

SYVAC3 uppH ei tim et a t  uM di tha  a m o tion  ra te  i t  to  ba avaiuatad in TIMSS(1..NT). Tha cafcnNaf r i  valaa 
am  returned in ALPHRE(1..NT).

Tha value o f logealO "  logr4 (I) -  .V4 (0. it computed in local variable EXPONA.

Multiplying by tha  Ujffaca a n a  y ttld t tha  c n  rat ion rate (or an antira conta inat.
[lueptyViluts)-

DO J  -  L.NT
C................Coavert uaad fu e l  doaa r a ta  co d ia a o ia tto a  ra ta

IF (TTMSSCJ) .LE. TDELTA) THEN 
ALPHRE (J) > O.DO 

ELSE
(.LofAlphtOcsaAtTune)
EXPOHA •  BALPBA ♦ AALPHA-OCALOG ~

I STDNOA*CALPHA>
1 SQRT(DALFHA*EALPHA*(DCAUG-FALPHA)««2)

ALPHRECJ) -  REFHAAaUSURFA*lO.DO"aEXPQNA 
EHD IF 

EtO 00

Evaluate tha log o f tha jaedictad alpha data lo*(ri) a t  a particular thna TIMSS(J). 
(LagAlpluD aeAtT im t)—

IF  (TIMSS (J) ♦TCOOL -L I. ALPHTICSINTCNQALPH))) THEE 
I - t
OOAFLS -  .TRUE.
OG WHILE Ctl .LE. fI*T(tOALPH)-I) .AHO. OCAFLG)

C..................... IX t l i a  i a  g ra a ta r  tbaa TDELTA d a ta ra io a  log  dota ra ta
:?  CALPETIU). EO. TIMSS(J) ♦TCOOL) THER 

DOALOG •  LOGIOCALFDRL(I))
OOAFLS • .FALSE.

C.....................In te rp o la te  doaa ra ta  valuea an  a  LOCIO b a a it
ELSE IF  (CTDtSS(J)♦TCOOL .ST. ALPHTKI)) .AID.

1 (TTISSCJ)♦TCOOL .LT. ALPHTXCm))) THEN
DOALOG •  L0GX0(AifDAL(I) )♦

:  (LOG10(ALFDRL(Ia t))-L3GlO(ALFDRL(I))//
1 (LOGIO(ALET3L(Ial)}-LSGlO(ALFTRL(I)})a
I  (L0S10(CRKSS(J)»TCS]L)mRSEL)-
:  LOClO(ALFTRLd)))

OOAFLS •  .FALSE.
END IF 
I  -  !♦ !

END 00
IF (OOAFLS) TEEN

C ........................... Valaot cannot ba tnterpalacad.
ESC •  'FUEL DOSE VALUES CANNOT BE INTERPOLATED '  
CALL UREXRCSOONAN.MSG.STOPP)

END IF 
ELSE

OOALOC ♦ LOCIO(ALFDRLCNINT(SCALPH)))
END IF

(inc lud t)-
C

INCLUDE ' MXUDOS.INC' 
INCLUDE -SPALFH.INC' 
INCLUDE 'SPRADI.INC* 
INCLUDE 'TDELTA.INC’

C

(dlracthas)s
IMPLICIT NONE

C

Figure B .l:  Example Deatgn Specification (5 o f  5).
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I  *“ >  t h l i  ( i l *  w as f M n m l  u t t H t i e i l l g r  b y  m a m  b a t t e r  a e t  a d i t  I t
t . . .  o u tp u t  g e n e r a t e d  b y  X : \U f d p _ ja 0 4 \C o n n g \U X J n c \v a r 0 0 0 4 \b in \d a r lg n lp e c .p l  a a  M .  M ar 1C 1 4 :0 1 :4 0  2001 
I —  s a ^ o a a a t  m a l e a
« . . .  X :\U fife_ a a 0 4 \C o iif i4 \IB X M S C \V a z 0 0 a t\b in \d a a ig n fp a c .p l  0 »
t  —  d a a lg a a p a e  021
1 . . .  W :/ lb a  a h r /m /X ^ /C C 4 0 2 /V l t /V 0 2 0 4 /d i a t i o a a c y /a c 4 /a l f d x l .d d d  0 U
1 . . .  > : / lb a ~ ■ b r /X S h /^ /C C 4 0 2 / V l t /V 0 2 0 4 /d le t lo a a r r / e e 4 /a l£ x o l .d d d  0 U
« . . .  W t/ lb a T a h r /X lh /X ^ /C C 4 0 2 /V l t /V 0 2 0 4 /d lc t la a a r y /e c 4 /a l f  t r l . d d d  0 U
« . . .  W :/Ib a r* h r /X n /X a p /C C 4 0 2 /V lt /V 0 2 0 4 /d le t lo a a x y P e e 4 /a lp h t l .d d d  O i l
« —  W :/X b a ~ a b r /m y ia v /C C 4 0 2 /V l t /V 0 2 0 4 /d lc t lo a a x y /c c 4 /c a o t ln .d d d  01B
« —  W :/Xbe a h r /X lb /Z ^ /C C 4 0 2 /V lt /V 0 2 0 4 /d lo t lo n a ry /o c 4 /d o a £ lg .( id d  O U
« . . .  « : /S b a ~ a h r /x n /X b v /C C 4 0 2 /V l t /V 0 2 0 « /d le t lo a a r r /e e 4 / l .d d d  011
« . . .  W :/lb a —a h r / I I h / I ^ /C C 4 0 2 /V l t /V 0 2 0 4 /4 1 c t lo n a r y /c c 4 / j .d d d  011
« . . .  W :/lb a ~ < h r /X n /I lp /C C 4 0 2 /V lt/V Q 2 0 4 /d le tlo a a x y /c e 4 /B O d n 4 B .d d &  011
« —  W :/«ba— abr/X H /X B V/CC402/V I  t/V 0 2 04/ d i c t i o n a r y / c c 4 / a a g .  d d d  011
« . . .  « : /H a ~ a h r /z n / lb v /e C 4 0 2 /V l t /V 0 2 0 4 /d le e i s a a r y /e e 4 /b B a d e a .d d d  011
1 . . .  W : / lb a ~ a h r / I l iy i^ /C C 4 0 2 /V l t /V 0 2 0 4 /d la t lo a a x y /o a 4 /D t .d d d  011
« . . .  W :/ lb a ~ ih x /in /X a « > /C C 4 0 2 /V lt/V 0 2 0 4 /d ic tlo < ia ry /c c « /a k .d d d  O la
« —  W :/X b a ~ a b r /m /I a p /C C 4 0 2 /V l t /V 0 2 0 4 /d lc t lo a a r y /e c 4 / r a f x a a .d d d  o i l
« . . .  W :/X b a ~ a h r /m /Ia v /C C 4 0 2 /V lt /V 0 2 0 4 /d lc t lo o a ry /c e « /< to p p .d d d  O i l
« . . .  « : / H a ~ a b r / m / I ^ / C C 4 0 2 / V l t / V 0 2 0 4 / d l c t l o a a x y / c c 4 / t d e l t a .d d d  01C
« . . .  W :/H a ~ a h r /X f l /a v /C C 4 0 2 /V l t /V 0 2 0 « /d ie e lo a a x y /a a 4 / t l a r a l .d d d  011
« . . .  W :/ lb a _ a b r /Z « l /Z ^ /C C 4 0 2 /V l t /V 0 2 0 « /d ia t ie a a r y /e a 4 /e ia a a  .d d d  011
« —  K :/a f d p _ a a 0 4 /a o n f ig /T h a a iX u /v m r 0 a 0 ] / lq u a t io iu /p r a d ic t a d C o r r l i a . tu < i  O U
« —  a :  /ttfdp^aaO O /oon f  i g / ThatiiMa ii/^ a rO O O l/lg q a tlo a a /p ra ril n f artTo g x lo g . ta q  0 11
« —  a :  / t t f ^ _ a a 0 4 /c o n f lg /d a t ig n /y e x 0 0 0 3 /D e 8 lq n D D /a a lp h a .d d d  01C
« —  a :/n f^ _ « a 0 4 /c o n f lg /< l» i1 g n /T a x 0 0 0 1 /P a « lq p D n /a l2 o o f  ,d d d  O U
«   « : /u f ^ ~ ia 0 4 /e o n f lg /d a a lq n /T a x 0 0 0 3 /D a « lg n C 0 /a lp h d o .d d d  0 U
t —  a : /B f^ _ ia 0 4 /o o a g lg /d a « lg a /a a r0 0 0 2 /I ) a a i iB ro » /a lp b « a .d d d  0 U
« —  a : / t t f ^ _ ia 0 4 /a o n f lg /d a a lg n /T a x 0 0 0 3 /P a a ig a D 0 /b « lp h « .d d d  0 U
« —  a :  /a fd p ~ a a 0 4 /ooiif  lg /d ea ip n /T eg O O O l/D ea lg p D D /ca lp ha .d d d  01C
«   a : /u l i^ ~ a a 0 4 /c o n f lg /d a a lg n /a a r 0 0 0 3 /P a a lg i lD D /c a l ty p .d d d  01C
« ----  W W M / K ^ i y W l ^ l p l i .  01C
« —  a : /a f ^ _ a a 0 4 /c o n f lg /d a a 1 g n /a a a 0 0 0 3 /P a a ig n P 0 /d o a lo g .d d d  0 U
t —  a : /a f ^ > ja a 0 4 /o o a < lg /d e t lq n /e o r0 0 0 3 /n a e 1  g n lin /a a lp h a .d d d  0 U
« —  a  : /n C 4 p ~ a a 0 4 /co ilf ig /d e s ig n /v ex 0 0 0 3 /D e e ig & 0 D /a a p o ee . d d d  01C
« —  , ; / ' r f ^ j ‘ M / , * , * t T /<** <r / * * ' (IIIM / ll** <<, m ^ * 1r k* <M‘* 01C
« . . .  a : /n f^ _ a a 0 4 /c o n f lg /d e a lg n /T e r0 0 0 3 / l> a a 1  g n n o /n o a lp h .d d d  0 U
« . . .  a : / t t f ^ ~ i« 0 4 /c o n f lg /d » a lg n /T a r 0 0 0 3 /T )a » lq n H n /i td n a « .d d d  0 U
« —  a : /a f ^ _ a a 0 4 /c o n f i g /d e a ig n /v e g 0 0 0 3 /Tte a1 y iltn / 1 coo l .d d d  01C
«   AdA 01C
\ r a n a » n » n i l ( \ f « « t l l y l a f a i i 1 1) Ian)
\ a a e c a t a d ( \ a i n t i r f r t e r H n t r 1 m p ) ( )
\ naenr— iiil ( \ n»anddaH ln a— Tlnpi) ()
\ilnnm an trlaaa  (Design* peel 
\uaapaekapa ( noaab I 
NpafleatyleCsMpty)

\ p x o d O G tU ( m  M ar 1C 1 4 :0 C :4 0  2001)\pxojaet(CC«)
\sabaB dal{Z H O C )
\ t l t l a ( 3 L H D C  :  l l a a l a t a  C o a l r a l a a a a  fxoai a lp h a  r a d l o l y a l a )
\aatbar(l.l. Oliver)
\varsioa{021)
\ d a t a ( r a b  2 3 , 2001)
\< ^ T — t a r f l . l .  Oliver)
M ^ l a a e n t m t a O f c r  1C, 2001)
\ r w l a a t l l . « .  I h l q k l  
\ r e v i a e O a t a ( l * r  1C, 2001)

\b a g la {  d s e m m it)
\ a a k a e i t l a  Vthl a p a g a a t y l a ( a ^ t y )

\ a a t l a a g t h ( \ p a r l a d a a t ) ( O i a )
\s a ttn h a ig b t( \p a rsk lp )  (X)
Variseries
\a a a e a M a a n d ( \a a p ) ( \b a g la ( p ie ta z a ) ( 1 0 0 ,2 0 ) (0 ,0 )  \ p a t ( 0 , 1 0 ) ( \ l i a a ( 1 0 0 ,0 ) ( 1 0 0 ) ) \ a o d ( p l e t a r a ) \ a a a l l a a )  
\v b o a (
Xnelnriant X bfaartaaM lM l Modala  coaponanta:

r ig u re  n . i :  P o ri 10a  op in e  tue gnneraiau oy ’IgXapnt/Tiuwcu u u in  l i i i  S p s d S a tS S  21c lil te d  In

Figure B J .
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B.2 Input

Figure B.3 shows the input Design Specification file used to generate Figure B.l. Other input information 

was extracted from the Design Data Dictionary, as indicated in Figure B.2. Mote that this file would typically 

be generated and maintained through the GUI.

The first section contains the identification information common to all TeXspec components.

The second section provides a  description for the module to be placed in both the code and the Design 

Specification. For the code, Fortran comment characters (a ‘C’ in column 1) are added.

The third lists the arguments to the module, in the order that they are to occur in the interface. Direction 

of data Sow must be stated. Preconditions and postconditions are optional, and are added to any conditions 

in the Design Data Dictionary.

The fourth section lists global (COMMON) variables. The order does not impact any products, but alpha­

betical order is often easier to read. Direction of data Sow, preconditions and postconditions are similar to 

the arguments.

The fifth section lists the local variables and any initializing data. Note the variable ‘MSG’ for which the 

dimension in the Design Data Dictionary has been overridden.

The next section lists constants used in the module. Values are extracted from the Design Data Dictionary.

The next several sections are free form KTfeX, which is processed to the commentary associated with the 

first code chunk.

The remaining sections are the user supplied code chunks.
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Figure B.3: In p u t required to  produce Figure B .l  (1 o f  4),
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Figure BJJt Inpu t required  to  produce Figure B.1 (2 o f  4).
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Figure B.3: In p u t required to  produce F igure B .l  (3 o f  4).
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Figure B.3: In p u t required  to  produce Figure B .1  (4 o f 4)
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C Sample PERL Script

Figure G.l lists one of the smaller TfeXspec PERL modules ‘ minispec.pl’. This listing is intended to illustrate 

the coding design and style used in all such modules.

T^Xspec contains are over 8,000 lines of PERL over 7 modules.

♦ J /u a r /b iR /p e r i. -w
4---------------------------------------------------------------------------------------------
♦ feXspec ro u tin e  to  p rocess  a •m ir.i-spec" s p e c if i c a t io n  
4 to  LaTeX com pliant input ‘ - -e 
i
4 usage: a in i2 p e o .p l  procesaN uncer • m m iip e c ri.e .m s
♦
* ::cc  : c t  i :  v*r ? : r  z .  - i iv * r
4

use Cwt i t

4 . . .  .HAKE iURE m a t  z r . i t  . 3  s e t  to  the  s c r ip t  v e rs io n  
Sversion. 50 » •")*?•; • . . .  <eep tra d e  *r th e  v e rs io n s  r r  \ l .  ocsxpcr.er.tr

d ie  ••tasqe: 20 arccessM ’uafcer ■ air»:£p*vc.a«" i f  9ARGV t ;  • cn«* .r.put param eter

* . . .  o th e r  g lo b a l v a r ia b le s :  -com posite. *cospcsite-Jsed
SnCoapositeUsed •  0 ; 4 —  jic b a i v a r ia b le  c r 'in ts  tew nar.y com posite rlcwa

* . . .  d e c la re  xr.d i n i t i a l i s e  .c c a l  v a ria b le s  t in  vase t h i s  becomes a su b ro u tin e  .u t e r
a y (3a u th o r) •  •a u th o r  r.zz d e fin ed * ;
« y (4 b lb lig ra p h y ) f  * . . .  ab ridged  c i t l ic p ra o h y
my(3bibTeX) * 0 ; * . . .  f la g  th a t  oicTeX b ib lio g rap h y  p ro c e ss in g  w i„ i be used 
a y U d t e ) ; « . . .  c i t a t i o n s  re fe ren ced  w ith • 'c i t e *
a y (S c u rren tS ec tio n ) •  *r.one*; 
a y (S cu rren tS ec r lonName) •  •* ; 
a y (fd a te )  * "d a le  ..c l le f .r .e d " ;
a y ( l t i f d ln ) ;  * . . .  inpu t flow s fc r  th i s  p ro c e ss  or th e  d a ta  flow diagram
ay (S d fd ln ty p e ); * . . .  tvpe o f  i lc *  .s ta t ic / 'te m p o ra l .  on th e  -data flow diagram
ay(gd fdO u t); » . . .  ou tpu t flows fo r tfc.s o rc c e s : on m e  la ta  flew l i j g r j n
ay (9df dOutType); •  type o f flow s ta t ic / te m p o r a l .  in m e  o a ts  flew d.avram
s y  iSdiagraoNumber) * SARGV[0];
ay tS fo caa tO p tio n sl •  **;
ay (® free F o ra l; * —  a<»r eu p p iieg  TeX
By(Simplementec) ■ - isp ie m e n te r  not :* tire d " ';
ayiSlopiementEJace) ■ ":xpLeser.tT»tte r.ct le f ined";
ay lG iaF lcw l; * . . .  in p u t l a t a  flows
ay(3nDffdtn) ■ Of * . . .  number of .r.put flows fo r  t h i s  p ro c e ss  or. th e  d a ta  flow diagram
ay(SnDfdOut) * Of * . . .  .number of ou tpu t flows to r  th is  p ro ce ss  or th e  ta la  flow diagram
aytSnFreeForm SeforelO) « 0 ;
aytSnlnElcw) » Of • . . .  .number o r inpu t r a ta  flow s
ay(SnCutFIowl •  0 ; * . . .  number of o u tp u t l a ta  flew s
ay (fo u tF lo w )f » . . .  o u tp u t la ta  flows
ay(SparentM sg) * • • ;
ay(SprocessName) ■
ay(SprocessNumber) •  $ARCV(0{f
ay(5pcolect) * " s rc ie tt net defined*;
ay(Spwd) •  cvdCl;  * . . .  p re s e n t werjeme d ire c to ry
ay tS rev iew eri •  •rev iew er .nut defm.e-d'f
a,/(5ceview D ate) •  • re v i-w E a t- n e t re f in e d * ;
ay (Scuntim e)f
my(Ssubaodel) •  •su rm ccei .to t d e f in e d " ; 
ayO usePackagel f ♦ . . .  TeX packages m a t  a re  used 
ay tS versicn lD ) •  •v e rs io n  number r.ct le fin e d * f

SceodRCf

$run tim e ■ I c c a l t i a e O f

Figure C*l; Example PERL M odule (1 o f  9).
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Figure C .Ir Example PERL Module (3 o f  9),
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Figure C .l t  Example PERL Module (4 o f  9),
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5 ? ' r ®

z  Z

■ o - o o  u - ^  • •  i. -n
Z'i?c’ 5* s " |  r i l l s  r r .  r f r r r r r r r r r r l r l r r

if IK  i i  i i i i i i i i i i i l i l i i
* cc cSSS?o £  t  S t i l
l l i I H i . 1 I  i s

SS S i s s s i i s i i t - i - i s
£ i  £ £ i i l l £ £ £ £ £  £ £1

Figure C J :  Example PERL M odule (5 o f  9).
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Figure C J :  Exam ple PE R L  M odule ( 6  o f  9).
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Figure C J :  fcxample fG K L  M odule (T o (  U),
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Figure C .Ir Example PERL M odule (8 o f  9). 
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D Sample Java Module (GUI)

Figure D.l lists one of the smaller T^Xspec Java modules ‘DesignSpecificationEditFrame.java’. This listing 

is intended to illustrate the coding design and style used in all such modules.

The T^Xspec GUI contains are over 32,000 lines of Java over 85 modules.

7T
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/ / T i t l e :  T e X s D e c  : D e s i c r n S D e c i f  i c a t x o n E d i t
/ / V e r s i o n :  0 .
/ / C o D V E i a h t :  C o D V E ia h t  ( c i  2
/ / A u t h o r :  S i e v e  O i l ’
/ / C o m D a n v :  U n i v e r s i t y  o f  M a in .;
/ / D e s c r i D t i c n :  G r a D h x c a l  i . i t e r f a c e  f o e  T e X s o e c  CASE

D a c k a a t  T e X s D e c G U ;

i n o o c t  i a v a . a w t . * ;  
i m D o r t  i a v a > . s w i n e . * ;  
i m o o r t  i a v a . a w t . e v e n t . * :

/  *  *

*  E d i t / C c e a t e  a  D e s i o n  S D e c i f i c a c .

*  S a u t h o r  <A  H R 2 F = " m a i l t c : c l i v e r s g a e c l . c a " : > S t e D h e n  C l i v
* g v e r s i c n  0 . 1 3 .  M a c  3 .  2 
'  /

o u b l i c  c l a s :  D e s i a n S D e c i f i c a t i o n E d i t F r ;  e x t e n d i  J l n t e c n a l F r a i r  

/ / . . .  i n s t a n c e  v a c i a t i  

/  * *

* u n d e c i v i n c  c a n e  
*/

D r i v a t t  J P a n e l  e d i t P a n e  =  n e w  J P a n e l  :
/ - *
*  l a y o u t  t o r  t h e  u r . o e c l v i n a  o a t  

/
o t i v a t t  G r i d B a a L a v o u  e d i t P a n e l L a v o t  =  n e w  S r id B a a L a v o u :  : 

/ * *

* D a n e l  f o e  co m m o n  T e X s o e c C c m D o n e n t  c o n t>

D r i v a t i  T e X s o e c C o m D o n e n t E d i t P a r  c o m o o n e n t P a n e ;

/  ♦ *

* D ane l  fo e  a e s i o n  SDec s o e c i t x c  c o n te  
' /

o n v a c i  D e s i a n S o e c i f i c a t i o n E d i t P a i  d e s i c n P a n e ;

/ * *

*  D anel £o e  " S A V E "  and " C A N C E L "  b u t t  
*/

D n v a t i  S a v e  C a n c e l  P a n t  b u t t o n P a n e  =  n e w  S a v e C a n c e l P a n t  ;

/
* D e s i a r .  S D e c i f i c a t r a n  t c  b e  e c i t e d  l o n a i  
'  /

o c l v a t t  D e s i a n S D e c i f i c a t i -  d s O l c ;

/  ' * ■

* D e s i a r .  D a t a  D i c t i o n a r y  E n t r y  t o  b e  e d i t e d  (m o d i
* /

D r i v a t t  D e s l a n S D e c i f l c a t i '  d s N e v ;

/* "
*  d a t a  x o d e i  t o r  t a b l e  o f  d e s i a n  s d  
*■/

D r i v a t t  T e X s D e c C o n m o a e n t T a b le M o c  d a t a M o d e .  ;

/ * *

*  U s e d  f o r  i r n e r a t i n c  l a y o u t  c o n s t r a i

Drivatt i n t  c u r R o v  =  0 ;

f ig u re  D*I; Ejutmpit? Jttvtt m uuum  {X u tu ; .
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/  *  *

*  C r e a t e s  a n  i n s t a n c

*  S o a r a m  t i t l e  t h e  S C r i n a  t o  d i s o l a v  i n  t h e  t i t l
*  S o a r a m  r e s i z a b l e  i f  t r u e ,  t h e  f r a m e  c a n  b e  r i
*  S o a r a m  c l o s a b l e  i f  t r u e ,  t h e  f r a m e  c a n  b e  c
*  S o a r a m  m a x i m i z a b l e  i f  t r u e ,  t h e  f r a m e  c a n  b e  m a x
*  S o a r a m  i c o n i f i a b l e  i f  t r u e ,  t h e  f r a m e  c a n  b e  i c o
*  S o a r a m  d  d e s i a r .  S o e c i f i c a t i o n  t c  b e  e-
*  S o a r a m  m d a t a H o d e l  f o r  J t a b l e  o f  S D e c i f i c a c i o n s  w h ich  mav b e  r
* /

o u b l i c  D e s i a n S D e c i f i c a t i o n E d i t F r ;  S t n n c  t i t l e ,  b o o l e a r  r e s i z a b l ,  
b o o le a c  c l o s a b l v  b o o l e a :  m a x i n u z a b l ,  b o o le a c  i c o n i f i a b l ,  
D e s i o n S D e c i f i c a t i -  d .  T e X s o e c C o m o o n e n t T a b le M o c  m.

s u o e :  t i t l e ,  r e s i z a b l ,  c l o s a b l . ,  m a x i m i z a b l ,  I c o n i f i a b l  ;

d sO lc  = d r
d s N e v  =  D e s i o n S D e c i f i c a t i '  d . c o D i  ;  
d a t a M o d e  =  m;

t r v
t b l n i t  ,*
D a c k i ;

c a t c l  E xceD tio - ex:
e x . D r i n t S t a c k T r a c  ;

/  "

* C r e a t e s  a r . i n s t a t e

*  S o a r a m  d  d e s i a r .  S o e c i f i c a t i o n  t o  b e  e-
*  S o a r a m  m d a t a M o d e l  f o r  J t a b l e  o f  s D e c i t i c a t i o n s  w h ic h  mav b e  r
* t

D u b lic  D e s i a n S D e c i f i c a t i o n E d i t F r .  D e s i a n S o e c i f i c a t i -  d,  
T e X s o e c C o m o o n e n t T a b le M o c  m;

t h i s ;  " D e s i a n  S D e c i t i c a t i o .  t r u e ,  t ru e ,  t r u e ,  t r u e ,  d ,  m. .*

/  *  *

•  C r e a t e s  a n  i n s t a n c e .  U s e d  b v  J H u i l d e r

D u b l i c  D e s i a n S D e c i f i c a t i o n E d i t F r ;
t h i s '  t r u e .  t r u e .  t r u e ,  t r u e ,  n u l l ,  n u l l : ;

/ ' *

•  I n i t i a l i :

D n v a t e  v o i c  i b l n i t '  th ro w : E x c e o t i o :

/ / . . .  s e t  u o  c o m m o n  T e X s c e c  c o m D o n e n t  e l e m e n t s  f o r  e< 
c o m D o n e n tP a n e  =  n e w  T e X s o e c C o m D o n e n t E d i t P a r  d s N e v  ;

/ / . . .  s e t  u o  d e s i c n  c a t a  c i c t i o n a r v  s c e c i t i c  e l e m e n t s  t o r  e  
d e s i a n P a n e  »  n e w  D e s i a n S D e c i f i c a t i o n E d i t P a i d s N e v  ;

I I . . .  s e t  u o  t h e  l i s t e n e r s  f o r  t h e  " S A V E ” 5 " C A N C E L ” b 
b u t t o n P a n e . a e t S a v e B u t t c  . a d d A c t i o n L i s c e n e  

n e w  1 a v a .  a w t .  e  v e n  t .  A c  t c  o n L i  s c e n e  ■
o u b l i c  v o i c  a c t i o n P e r f o r m e  A c t i o n E v e n  e :  
s a v e B u t t o n  a c t i o n P e r f o r m e : ;

b u t t o n P a n e . a e t C a n c e l B u t t c  . a d d A c t i o n L i s t e n e

P W ix n s. t>  CvmmwU i T a w - M  o f  KV
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n e w  i a v a . a w t . e v e a t . A c t i o n L i s t e n e - :
o u b l i c  v o i c  a c t i o n P e r f o r r a t A c t i o n E v e n  e :  
c a n c e l B u t t o n  a c t i o n P e r f o r r e ;  ;

/ / . . .  s e c  u d  t h e  s a i n  o a r
a e t C o n t e n t P a r  ■ . s e t L a v o u  n e w  G r id B a a L a v o u i  
a e t C o n t e n t P a r  1 .a d c ic o m n o n e n t P a n e ,  

n e w  G r i d B a a C o n s t r a i n
0 ,  0 ,  / /  a r i d  d o s  x .
G r i d B a c C o n s t r a i n . R E M A I N D E , 1 .  
/ /  a r i d  w i d t h ,  h e i a
1 . C .  O .C .
/ /  w e i c h t  x .
G r i d B a a C o n s t r a i n . E A S T ,
G r i d B a a C o n s t r a i n . H O R I Z O N T A ,
/ /  a n c h o r ,  f t l
n e w  I n s e t :  0 .  0 ,  0 ,  0 ,
/ /  m s e c  
5.  2
/ /  c a d x .  o a d

a e t C o n t e n t P a r  . a d r d e s i a n P a n e .
n e w  G r i d B a a C o n s t r a i n

0 ,  I ,  / /  a r i d  o o s  x .  
G r i d B a a C o n s t r a i n . R E M A I N D E , 1 ,  /  /  
a r i d  w i a t h ,  h e i a l
1 . e .  l . C .
/ /  w e t c h t  x ,
G r i d B a a C o n s t r a i n . E A S T ,  
G r i d B a a C o n s t r a i n  .B O T E , / /
a n c h o r ,  : i -  
n e w  I n s e t :  0 ,  0 ,  0 ,  O ' ,
/ /  m s e c .
5 ,  2
/ /  o a d x . o a d

a e t C o n t e n t P a r  . a d d 'b u t t o n P a n e ,  
n e w  G r i d B a a C o n s t r a i n

0 ,  2 ,  / /  a r i d  d o s  x ,
G r i d B a a C o n s t r a i n . R E M A I N D E .  1 .  /  /  
a n d  w i d t h ,  h e i a i
1 .C .  O .C .
/ /  w e i c h t  x .
G n d B a c C o n s t r a i n  .E A S T , 
G r i d B a c C o n s t r a i n  .H O R IZ O N T A ,
/ /  a n c h o r ,  f i l
n e w  I n s e t :  0 ,  0 ,  0 ,  0 ,
/ /  i n s e t  
5 .  2
i 1 c a d x .  o a d

/  "
*  G e n e r a t e  l a y o u t  c o n s t r a i n t s  f o r  m o s t  f .

*■ 3 D a r a m  w i d t h  a r i d  w i d t h  :<0 = e n d  c f  r o w.  0 = r e m a i n d e r
*  /

D r i v a t t  G r i d B a a C o n s t r a i n  l a v o u t ; i n t  w i d t h
r e t u r r  l a v o u t i  w i d t h ,  G r i d B a a C o n s t r a i n - . C E N T E I . r

/ * *

*  G e n e r a t e  l a v o u t  c c n s t r a i

p r^ ...r  Javs. irfirfTjfe* (2  g f  S),
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* SDaram w id t h  c r i d  w id t h  (<Q = end a t  row. 0 =
*  S o a r a m  a n c h o r  s e e  G r i d B a a C c a s t r a
* /

o r i v a t i  G r i d B a a C o n s t r a i n - l a v o u t i  i n t  w i d t t ,  i n t  a n c h o r  
G r i d B a a C o n s t r a i n -  r e t V a l =  n u l l ;

i f : w i d t t  < =  O'.
i f  w i d t t = 0

w i d t t  «  G r i d B a a C o n s t r a i n . R E M A I N D E ;  
e l s e  

w i d t t  =  - w i d t t ;

r e t V a l *  n e w  G r i d B a a C o n s t r a i n -
G r i d B a a C o n s t r a i n . R E L A T I V , c u r R o v M - ,  / 
w i d t t ,  1 , i
h e r a h t
1 .  C, 0 .  C, /
a n c h o j ,  G n d 3 a a C c n s t r a i n  .B O T E , /
n e w  I n s e t ;  0 .  0 .  0 .  0  . i
0 , 2  /

e l s e
r e t V a l  «  n e w  G r i d B a a C o n s t r a i n

G r i d B a a C o n s t r a i n . R E L A T I V " ,  c u r R o i .  / .  
w i d t t ,  1 , '•
1 .  C, 0 .  C. / .
a n c h o i .  G r i d B a a C o n s t r a i n  .N O N E , / ,
ne w  I n s e t ;  0 ,  0 ,  0 ,  0  ,  / .
5, 2 / .

r e t u r t  r e t V a C ;

/  * *
■ G e n e r a t e  l a v o u t  c o n s t r a i

*- S o a r a m  w i d t h  a r i d  w i d t h  i< 3  =  e n d  o f  r o w .  3 =
*  S o a r a m  a n c h o r  s e e  G r i d B a a C o n s t r a
*  S o a r a m  f i l l  s e e  G r i d B a a C c r . s t r a
* /

D r i v a t t  G r i d B a a C o n s t r a i n  l a v o u t i  i n t  w i d t t .  i n t  a n c h o i  
G r i d B a a C o n s t r a i n -  r e t V a l =  n u l l ;

i f : w i d t t  < =  0 ’< 
i f :  w i d t t = 0

w i d t t  *  G r i d B a a C o n s t r a i n  .R E M A IN D E ;
' e l s e  '

w i d t t  =  - w i d t t ;

r e t V a l =  n e w  G r i d B a a C o n s t r a i n -
G r id B a a C o n s  t r a i n -.R E L A T IV : ,  c u r R o v n - ,
w i d t t ,  1,
h e i a h t
l . C .  0 . 1 ,
a n c h o i ,  f i l l ,
o o i i c i
n e w  I n s e t ;  0 .  0 ,  0 ,  0 .
0 ,  2

e l s e
r e t V a l  =  n e w  G r i d B a a C o n s t r a i n - ’

G r i d B a a C o n s t r a i n - - R E L A T I V : ,  c u r R o s ,  /  
w i d t t ,  1 .  t
0.1 . 0 .1 . /
a n c h o i .  f i l l .  /

81

r e m a i n d e r

/  a n d  c o s  x ,  
/  c r i c  w i d t h .

/  w e i a h t  x .
/  a n c h o r ,  f i l  
/  i n s e t .
/  o a d x ,  D a d

'  a r i d  d o s  x .
( a r i d  w i d t h ,  h e i a  
I w e i c h t  x .
! a n c h o r ,  f i l  
! i n s e t  
t o a d x .  o a d

r e m a i n d e  r

i n t  f i l l

/ /  e n d  o o s  x .
/ /  a r i d  w i d t h .

/ /  w e i a h t  x .
/ /  a n c h o r ,  r e s i f

/ /  i n s e t .
/  /  o a c x .  o a d

/  a r i d  d o s  x .
/ a r i d  w i d t h ,  h e i a  
/  w e i c h t  x .
/  a n c h o r ,  r e s i n
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D O llC ’v
n e w  l n s e t : ' 0 ,  0 ,  0 .  0 - ,  / /  i n s e t
5 ,  2  / /  o a d x ,  c a d

r e c u r :  r e t V a . 1 ;

’  S e s D o n d  t o  m o u s e - c l i c k  o n  t h e  " S A V E "  D ushb

•  3 o a r a m  e  e v e n t  f r o m  <
" /

D r i v a t t  v o i c  s a v e B u t t o n  a c t i o n P e r f o r n . A c t i c n E v e n  e :  
c o m D o n e n t P a n e . r e c o r d D a t  ; 
d e s i a n P a n e . r e c o r d D a t  :  
i f -  d s O l c . a e t N a m t '  . e a u a l s 'd s N e v . a e t N a m n  

d s N e v . c o D v T c  d s O l c .  ;  
t r v

d s O I c . w r i t e '  ;
b u t t o n P a n e . a e t C a n c e l B u t t c  . s e t T e x i ;  " E x i t "  ;  ;

c a t c h  T e X s c e c E x c e o t i c  e x
E x c e D t i o n D i a l c  d l a  =  n e w  E x c e D t i o n D i a l c :  C o n f i a u r a t i o .  
a e t D e f a u l t F r a n  ,  " T e X s o e c  , t r u e , T e X s D e c E x c e D t i c . e r r o n  
" C o u l d  n o t  s a v e  D e s i a n D I + "  " - e x . d e s c r i D t i o  !
D i m e n s i o -  d l a S i z t  =  d l c . a e t P r e f e r r e d S i t ;  ;
D i m e n s i o  f r m S i z t  =  a e t S i z i  ;
P o i n t  l o c  =  a e t L o c a t i o  ;
d l a . s e t L o c a t i o  f r m S i z e . w i d t f c  -  d l a S i z i . w i d t t  /  2  +  l o c . x ,  
f r m S i z i . h e i a h t  -  d l a S i z t . h e i a h r  /  2  +  l o c .  v  ;  
d l a . s h o w '  ;

e l s e
t r v

dsNev.writf •;
b u t t o n P a n e . a e t C a n c e l B u t t c  . s e t T e x i i  " E x i t "  ;  ;
I f ;  d a t a M o d e  ! =  n u l l  d a t a M o d e . a d d C o m D o n e n  d s N e v  ;  / / . . .
u D d a t e  J t a b l

c a t c t ’ T e X s c e c E x c e o t i c  e x
E x c e D t i o n D i a l c  d l a  =  n e w  E x c e D t i o n D i a l c  C o n f i a u r a t i o .  
a e t D e f a u l t F r a n  , " T e x s c e c  . t r u e . T e X s D e c E x c e o t i c . e r r o i ,  
" C o u l d  n o t  c r e a t e  r .e w  D e s i c n D + "  " + e x . d e s c r i D t i o  
D i m e n s i o ;  d l a S i z t  =  d l c . a e t P r e f e r r e d S i r  ;
D i m e n s i o .  f r m S i z t  =  a e t S i z i  ;
P o i n t  l o c  =  a e t L o c a t i o  r
d l a . s e t L o c a t i o '  f r m S i z i . w i d t t  -  d l a S i z i . w i d t t  /  2  +  l o c . x ,  
f r m S i z i . h e i a h t  -  d l a S i z t . h e i a h t i  /  2  +  l o c . v :  ;  
d l a . s h o v '  ;

/ * *

* P .esDona t o  m o u s e - c l i c k  o n  t h e  " C A N C E L "  oushfc

*  3Daram e  e v e n t  from  t 
'  I

D rivatt voic cancelButton actionPerfori'AczicnEven e
disoosi

m g u re  u u :  e x a m p le  J a v a  rvioauie (a  oc a / .  

82

Reproduced with permission of the copyright owner. Further reproduction prohibited without permission.



www.manaraa.com

E Installation

E.1 Prerequisite Software

TfejXspec relies on a number of tools which are available without charge and can be downloaded from various 

Internet sites. These tools can be installed on various computing platforms. Each of these tools must be 

installed on a system before l^Xspec can be installed. TfejXspec should operate on any platform where each 

of these tools has been installed.

E.1.1 Peri

The main TfeXspec processing is performed by modules which have been implemented in PERL [28]. Peri 

Version 5 was used to develop l£Xspec, and earlier versions are unlikely to be compatible.

E.1.2 TgCandBTgC

Various distributions of TfejJC and BTfejX exist for many platforms. TJjjXspec has been tested on the TelfeX 

and Mik'I^X distributions, but should be compatible with any other valid distribution.

Some distributions do not contain the xy-pic package which provides drawing capabilities that TfeXspec 

uses to produce Data Flow Diagrams and Structure Charts, or the vmargin package, which TfejXspec uses 

to control margins. If the selected distribution does not include either of these packages, then the missing 

package(s) must be downloaded and installed within the IfeX installation. Installation of extension packages 

is detailed in documentation of the TfeX distribution.

E.1.3 Noweb

Noweb is a  combination of executable programs and a extension package. Detailed installation in­

structions are provided for various platforms with, the Noweb distribution.

Microsoft Windows-NT users should be aware of the incompatibility of Windows-NT with the Noweb dis-
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tribution binaries (executable images) for other Microsoft Windows systems. Instructions are included with 

the Noweb distribution for building NT binaries.

E.1.4 JAVA Runtime Environment

Users wishing to run the Graphical User Interface must install a Java Runtime Environment that includes 

the "Swing" libraries. TfeXspec has been tested on Sun Microsystem’s JRE version 1.2 and 1.3, but IfeXspec 

should be compatible with any Swing enabled environment.

E.2 TgXspec Specific Installation

The TkjXspec distibution includes:

• A number of Perl scripts. If T^Xspec is to be run horn the command line, then some platforms prefer 

these to be placed in a particular location. If the GUI is to be used, then the scripts can be placed 

anywhere provided that the GUI search list is updated to look in that location.

• GUI "batch" files. For each Perl script, a file is required to interface between the GUI and Perl. 

The T£Xspec distribution includes samples for Microsoft Windows environments. These files are only 

required if the GUI is to be used, and can be placed anywhere provided that the GUI search list is 

updated to look in that location.

• A Java ARchive (.jar) file containing the executable GUI. This can be placed anywhere, provided that 

the Java Runtime Environment can access it.

• A class (.els) file for each publishable product. These must be placed in the I^IfeX installation. Instal­

lation of new class files is detailed in documentation of the distribution.

84

Reproduced with permission of the copyright owner. Further reproduction prohibited without permission.



www.manaraa.com

References

[1] Advanced Software Technologies Graphical Designer, http://www.advancedsw.com

[2] J.J. Bunn. Floppy and Flow User ManuaL http://vscrna.cern.ch/floppy/contents.html, 1997.

[3] Cadre Technologies, Providence RI. Teamwork.

[4] Canadian Standards Association. Quality Assurance o f Analytical, Scientific, and Design Computer 

Programs for Nuclear Power Plants. Technical Report N286.7-99, 1999. 178 Rexdale Blvd. Etobicoke, 

Ontario, Canada M9W 1R3.

[5] T. DeMarco. Structured Analysis and System Specification. Yourdon Press/Prentice-Hall, 1978.

[6[ Digital Equipment Corporation, Maynard Massachusetts. Guide to DECdesign. 1992.

[7] R. Eckstein, D. Wood, and M. Loy. Java Swing. O’Reilly & Associates Inc., 1998.

[8] B.W. Goodwin, T.H. Andres, D.C. Donahue, W.C. Hajas, S.B. Keeling, C.I. Kitson, DAI. LeNeveu, 

T.W. Melnyk, S.E. Oliver, J.G. Szekely, A.G. Wikjord, K. Witzke, and L. Wojciechowski. The Disposed 

o f Canada’s Nuclear Fuel Waste: A Study o f Postclosure Safety o f In-room Emplacement of Used 

CANDU Fuel in Copper Containers in Permeable Plutonic Rock. Volume 5: Radiological Assessment 

Technical Report AECL-11494-5,COG-95-552-5, Atomic Energy of Canada Ltd, 1996.

[9J B.W. Goodwin, D.B. McConnell, T.H. Andres, W.C. Hajas, D.M. LeNeveu, T.W. Melnyk, G.R. Sher­

man, M.E. Stephens, J.G. Szekely, P.C. Bera, C.M. Cosgrove, K.D. Dougan, S.B. Keeling, C i. Kit­

son, B.C. Kummen, S.E. Oliver, K. Witzke, L. Wojciechowski, and A.G. Wikjord. The Disposal of 

Canada’s Nuclear Fuel Waste: Postclosure Assessment o f a Reference System. Technical Report AECL- 

10717,COG-93-7, Atomic Energy of Canada Ltd, 1994.

[10] E.M. Gurari. TrX ' and DT$C: Drawing and Literate Programming. McGraw-Hill, 1994.

[11] Interactive Development Environments, San Francisco, CA. Software Through Pictures. 1992.

[12] D.E. Knuth. Literate Programming. Center for the Study of Language and Information, 1992.

[13] L. Lamport. DTj$C: A Document Preparation System  Addison-Wesley, Reading Massachusetts USA, 

1986.

[14] J.W. Leis. DTtfCcad - a Drawing Package fo r &I%jX2e. Communications of the TeX User Group Vol. 21 

No. 1,2000. http://www.eeng.dcu.ie/ csg/latex/latexcadJitml

[15] D.M. LeNeveu. Analysis Specifications for the CCS Vault ModeL Technical Report AECL-10970.COG- 

94-100, Atomic Energy of Canada Ltd, 1994.

85

Reproduced with permission of the copyright owner. Further reproduction prohibited without permission.

http://www.advancedsw.com
http://vscrna.cern.ch/floppy/contents.html
http://www.eeng.dcu.ie/


www.manaraa.com

[16] T.W. Melnyk. INROC Theory Manual Technical Report (unassigned), Ontario Power Generation, 

2000. in draft.

[17] S. Oliver. Computer Program Abstract - INROC 01. Technical Report 06819-03787.1-T10, Ontario 

Power Generation, 1999.

[18] S. Oliver, K. Dougan, K. Kersch, C. Kitson, G. Sherman, and L. Wojciechowski. Unit Testing - a 

Component of Verification o f Scientific Modelling Software. In T J. Oren and G.B. Birta, editors, 1995 

Summer Computer Simulation Conference, pages 978-983. The Society for Computer Simulation, 1995.

[19] M. Page-Jones. The Practical Guide to Structured Systems Design. Yourdon Press, 1980.

[20] R. Pressman. Software Engineering: A Practitioner’s Approach. McGraw-Hill, 4th edition, 1996.

[21] N. Ramsey. Literate Programming Simplified. IEEE Software, September 1994.

[22] J. Robbins. ArgoUML Object Oriented Design Tool 2001.

[23] K. Rose. Very High Level 2-Dimensional Graphics. TeX User Group Conference 1997. http://www.ens- 

lyon.fr/ krisrose/Xy-pic.html

[24] I. Sommerville. Software Engineering. Addison-Wesiey, 6th edition, 2000.

[25] W.R. Stevens. UNIX Network Programming, Volume I: Networking APIs - Sockets and XTI. Prentice- 

Hall, 1997.

[26] W.R. Stevens. UNIX Network Programming, Volume 2: Interprocess Communications. Prentice-Hall, 

1998.

[27] P.D. Stotts. Tools Review: ‘Software Through Pictures’ from IDE. Journal of Visual Languages and 

Computing, 4 p201-204, 1993.

[28] L. Wall, T. Christiansen, and R. Schwartz. Programming Perl O’Reilly & Associates, 101 Morris Street, 

Sebastopol, CA 95472, second edition, 1989.

[29] R.J. Wieringa. Requirements Engineering: Frameworks for Understanding. Wiley, 1996.

[30] E. Yourdon. Modern Structured Analysis. Yourdon Press/Prentice-Hall, 1989.

86

Reproduced with permission of the copyright owner. Further reproduction prohibited without permission.

http://www.ens-


www.manaraa.com

Glossary

AECL Atomic Energy o f Canada Ltd

A P I Application Program Interface A set of routines, protocols, and tools for building software applications. 

An API facilitates program development by providing pre-defined components.

A SCII American Standard Code for Information Interchange A code for representing English characters 

as numbers, with each letter assigned a number from 0 to 127.

CASE Computer Aided Software Engineering A category of software that provides a development envi­

ronment for software programming. CASE systems offer tools to automate, manage and simplify the 

development process.

CERN  European Laboratory for Particle Physics European Organization for Nuclear Research, the world’s 

largest particle physics centre.

CNSC Canadian Nuclear Safety Commission Regulator of nuclear energy and materials in Canada.

configuration m anagem ent system  A system to identify and manage change, keeping a record for his­

torical reference.

C P /M  Control Program for Microprocessors Created by Digital Research Corporation, CP/M was one of 

the first operating systems for personal computers.

CSA Canadian Standards Association A not-for-profit, nonstatutory, voluntary membership association 

engaged in standards development and certification activities.

Symbolic Debugger A program used to find defects (bugs) in other programs. A debugger allows a 

programmer to stop a program at a  specified point and examine and change the values of variables.

DFD Data Flow Diagram A high level abstraction of software requirements showing conceptual processes 

and the flow of data between them.

DGRTP Deep Geologic Repository Technology Program

Design. Specification The specification for a  single compilable module.

FSF The Bee Software Foundation

G U I Graphical User Interface Pronounced goo-ee. A program interface that takes advantage of the com­

puter’s graphics capabilities to make the program easier to use. Well-designed graphical user interfaces
fy y  f m m  I f tn « n tq < r iw
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ISO International Organization for Standardization Derived from the greek word iso, which means equal. 

Founded in 1946, ISO is an international organization composed of national standards bodies from 

over 75 countries.

Java A general purpose, high-level programming language developed by Sun Microsystems. Java is an 

object-oriented language similar to C++, but simplified to eliminate language features that cause 

common program m ing errors. Java source code files are compiled into a format called bytecode, which 

can then be executed by a Java interpreter. Compiled Java code can run on most computers because 

Java interpreters and runtime environments, known as Java Virtual Machines (VMs), exist for most 

operating systems, including UNIX, the Macintosh OS, and Windows. Bytecode can also be converted 

directly into machine language instructions by a ‘just-in-time’ compiler.

A typesetting system based on the TfeXprogramming language developed by Donald E. Knuth. Most 

people who use TfeXutilize a macro package that provides an easier interface. DTfcjX, originally written 

by Leslie Lamport, is one of the most popular. KTfeXprovides higher-level macros, which makes it 

easier to format documents but sacrifices some of the flexibility of I^X.

M acintosh A popular model of personal computer made by Apple Computer, featuring a  graphical user 

interface to make it relatively easy for novices to use the computer productively.

M athT ype An interactive tool for Windows and Macintosh from Design Science Inc that assists in the 

creation of mathematical notation for word processing, and for T£X& DTfeXand MathML documents

M ini-spec Process Specification The description of what is happening in a  bottom level, primitive bubble 

in a dataflow diagram.

MS-DOS MicroSoft Disk Operating System Originally developed by Microsoft for IBM, MS-DOS was the 

standard operating system for IBM-compatible personal computers

M S-W in Microsoft Windows A family of operating systems for personal computers owned by Microsoft 

Inc.

N286.7 CSA Standard for the Quality Assurance of Analytical, Scientific, and Design Computer Programs 

for Nuclear Power Plants.

0 0  Object Oriented A special type of programming that combines data structures with functions to create 

re-usable objects.

O PG  Ontario Power Generation A company owned by the Government of Ontario which operates the 

majority of Canadian nuclear reactors.
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P C  Personal Computer The first personal computer produced by IBM was called the PC, and increasingly 

the term PC came to mean IBM or IBM-compatible personal computers, to the exclusion of other 

types of personal computers, such as Macintoshes.

PERL Practical Extraction and Report Language A programming language developed by Larry Wall, 

especially designed for processing text. Perl is an interpretive language, which makes it easy to build 

and test simple programs.

S tructure C hart An abstraction of software design showing software modules, usually as a tree, and the 

flow of data between them.

search list A list of directories to be searched sequentially for a file of a given name. The occurance of the 

file at a higher level in the list effectively superceeds files of the same name in directories lower in the 

list.

SGML Standard Generalized Markup Language A system for organizing and tagging elements of a doc­

ument. SGML was developed and standardized by the ISO in 1986. SGML itself does not specify 

any particular formatting; rather, it specifies the rules for tagging elements. These tags can then be 

interpreted to format elements in different ways.

T C M  Toolkit for Conceptual Modeling R.J. Wieringas’ collection of software tools to present conceptual 

models of software systems in the form of diagrams, tables, trees, and the like.

TRAD E Toolkit for Requirements And Design Engineering R.J. Wieringas’ Toolkit for Requirements And 

Design Engineering.

UNIX Pronounced yoo-niks. A popular multi-user, multitasking operating system developed at Bell Labs 

in the early 1970s.

W 3C World Wide Web Consortium An international consortium of companies involved with the Internet 

and the Web.

XML Extensible Markup Language A specification developed by the W3C. XML is a pared-down version 

of SGML, designed especially for Web documents. It allows designers to create their own customized 

tags, enabling the definition, transmission, validation, and interpretation of data between applications 

and between organizations.

X-Windows A windowing and graphics system developed at the Massachusetts Institute of Technology. 

Almost all UNIX graphical interfaces are based on X-Window.
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